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New Installation Checklist 
The following is a checklist of the overall steps needed to install Costpoint 7.1.1. Details for each step are 
provided on subsequent pages.  

Print this checklist and use it as you complete this installation if desired. 

Done? Step Notes 

 

Step summary… Any pertinent notes… 

Database Tier Installation 

 1. Create Costpoint 7.1.1 Oracle Instance(s) and 
Tablespaces 

 

 2. Install Costpoint Database using Database Tier 
Installer 

 

 3. Apply Partitioning Script for Performance 
Enhancement (optional) 

 

Application Tier Installation  
 1. Install Application Tier Software  

 2. Add Users to the CostpointToolsGroup  

 3. Start Costpoint 7.1.1  

 4. Install Costpoint 7.1.1 Windows Service  

 5. Configure Costpoint 7.1.1 Windows Service  

Web Tier Installation (Microsoft IIS) 
 1. Configure Microsoft IIS for Costpoint 7.1.1  

 2. Install Web Tier Software  

 3. Add Users to the CostpointToolsGroup  

 4. Configure Costpoint 7.1.1 IIS Access  

 5. Restart Costpoint 7.1.1 WebLogic Server  
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Done? Step Notes 

Using Costpoint 7.1.1 
 1. Set Web Browser Internet Options  

 2. Log in to Costpoint 7.1.1  

Post-Installation 

 1. Install Latest Costpoint 7.1.1 Hot Fixes.  

Related Documentation 
The following table lists the additional documentation that downloads along with this release. Except 
where noted, all the user guides and quick reference guides listed in this table are also available for 
download from the Deltek Customer Care Connect site. 

You will need Adobe Reader 8.0 or higher to view the documents listed in this section. 

Release Notes 

Document Name Description 

Deltek Costpoint 7.1.1 Database Changes This document describes the database changes 
between the release of Costpoint 7.0.1 and Costpoint 
7.1.1. 

Deltek Costpoint 7.1.1 Release Notes 
Enhancements 

Major New Features and Enhancements: Click this 
bookmark to view the major new features and 
enhancements included in Costpoint 7.1.1. 

De-Supported Applications: Click this bookmark to 
view the applications that are no longer supported in 
Costpoint 7.1.1. 

Deltek Costpoint 7.1.1 Release Notes 
Software Issues Resolved 

This document describes the issues that were 
resolved between the release of Costpoint 7.0.1 and 
Costpoint 7.1.1. 

Deltek Costpoint 7.1.1 Release Notes 
Software Issues Resolved Cumulative Update 

This document describes the issues that were 
resolved in the Costpoint 7.1.1 cumulative update. 
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Entity Relationship Diagrams (ERDs) 

Document Name Description 

DeltekCostpoint711TransactionSchemaERD.zip ZIP file containing the ERD for the Deltek Costpoint 
7.1.1 Transaction schema. Use index.htm to view 
the ERD. 

DeltekCostpoint711SystemSchemaERD.zip ZIP file containing the ERD for the Deltek Costpoint 
7.1.1 System schema. Use index.htm to view the 
ERD. 

DeltekCostpoint711AdminSchemaERD.zip ZIP file containing the ERD for the Deltek Costpoint 
7.1.1 Admin schema. Use index.htm to view the 
ERD. 

Technical Guides 

Document Name Description 

Deltek Costpoint 7.1.1 Configuration Utility This document describes how to use the Costpoint 
Configuration Utility, which helps Costpoint 
administrators perform the most common 
configuration tasks. 

Deltek Costpoint 7.1.1 Content Management 
Integration 

This document describes how to configure and tune 
the Costpoint Content Management Integration 
(CMI) application to provide access to Microsoft 
SharePoint™, as well as other Content 
Management Systems (CMS) that are compliant 
with the Content Management Interoperability 
Standard (CMIS). 

Deltek Costpoint 7.1.1 DB Wizard Utility This document describes how administers can use 
the DB Wizard utility to apply hot fixes and database 
structure changes to Costpoint installations. 

Deltek Costpoint 7.1.1 Deploying Hotfixes This document describes how to apply hot fixes to 
Costpoint 7.1.1. 

Deltek Costpoint 7.1.1 Deployment Options 
Technical Overview 

This document provides a high level overview of 
various Costpoint configuration options, including 
server, database, and security options. 

Deltek Costpoint 7.1.1 Integration Overview This document provides a high level overview of 
how Costpoint reports, processes, and data can be 
integrated with third-party applications via Web 
services. 

Deltek Costpoint 7.1.1 Integration Console This document is a detailed guide to the Costpoint 
Integration Console, which automates the process 
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Document Name Description 

of integrating Costpoint reports, processes, and 
data with third-party applications via Web services. 

Deltek Costpoint 7.1.1 Message Boards This document describes how integration between 
Costpoint and MS Exchange can enable 
collaboration among Costpoint users as well as 
between Costpoint and non-Costpoint users. This 
capability also allows you to link emails with 
attachments directly to Costpoint documents and 
view them directly from Costpoint. 

Deltek Costpoint 7.1.1 Monitoring Utility This document describes how to use the Monitoring 
Utility to diagnose Costpoint configuration problems. 

Deltek Costpoint 7.1.1 Performance 
Optimization 

This document contains Costpoint performance tips 
and tricks, information on the configuration of the 
Deltek performance lab, as well as a list of 
optimized applications for the Oracle parallel SQL 
execution option. 

Deltek Costpoint 7.1.1 Post Installation 
Hardening Guide 

This document presents common principles and 
recommendations that administrators should 
consider for post-installation hardening of the 
Costpoint server environment. 

Deltek Costpoint 7.1.1 Process Execution 
Modes 

This document describes the many options for 
executing reports and processes in Costpoint, 
including using interactive and batch modes and job 
servers. 

Deltek Costpoint 7.1.1 Security This document describes user authentication and 
other security safeguards in Costpoint. 

Deltek Costpoint 7.1.1 User Migration Utility This document describes how to migrate users from 
earlier Costpoint versions to Costpoint 7.1.1. 

Other Documents 

Document Name Description 

Deltek Costpoint 7.1.1 Getting Started Guide This document describes instructions for accessing 
Costpoint’s applications as well as descriptions of 
menus, toolbars, and other global features. You will 
also find information on logging on to Costpoint, 
accessing the database, printing reports, reviewing 
online help, and contacting Deltek Customer Care 
and other client services. 

Deltek Costpoint 7.1.1 User Interface QRC This document is a quick reference card which can 
be kept handy and used for reference as you 
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Document Name Description 

navigate Costpoint 7.1.1. It describes how to 
navigate through the application. 

Deltek Costpoint 7.1.1 Shortcut Keys Toolbar 
Icons And Buttons QRC 

This document is a quick reference card which can 
be kept handy and used for reference as you work 
in Costpoint 7.1.1. It lists the shortcut keys available 
in Costpoint, as well as the toolbar icons and 
buttons. 

Deltek Costpoint 7.1.1 Views QRC This document is a quick reference card which can 
be kept handy and used for reference as you work 
with the Costpoint 7.1.1. It explains the differences 
between Table View and Form View. 

Deltek Costpoint 7.1.1 Query and Lookup QRC This document is a quick reference card which can 
be kept handy and used for reference as you work 
with the Costpoint 7.1.1. It explains how to use the 
query and lookup functions in Costpoint, 

Deltek Costpoint 7.1.1 Extensibility Designer 
Coding Guide 

This document contains java coding information for 
Costpoint Extensibility developers. 

Deltek Costpoint 7.1.1 Extensibility Designer 
Quick Start Guide 

This document outlines the basic steps for creating 
and deploying extensibility. 

Deltek Costpoint 7.1.1 Extensibility Designer 
Report Guide 

This document describes how to extend a report. 

Deltek Costpoint 7.1.1 Extensibility Designer 
User Guide 

This document contains detailed instructions for 
using the Costpoint Extensibility Designer. 

Deltek Costpoint 7.1.1 Screen Customization 
and Business Logic Extensibility 

This document is an overview of Costpoint’s screen 
customization and business logic extensibility 
features. 
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New Installation Overview 
This document provides instructions for installing the Deltek Costpoint 7.1.1 software. During the 
installation process, you will perform the following: 

 Ensure that your system meets the installation prerequisites. 

 
 Install the Costpoint 7.1.1 Database Tier software to create your Costpoint 7.1.1 Transaction, 

System, and Admin databases. 

 Install the Costpoint 7.1.1 Application Tier software, which includes both the Oracle WebLogic® 
Server software and the Costpoint 7.1.1 software. 

 Install the Costpoint 7.1.1 Web Tier software to your Internet Information Server, if applicable. 

 Install the latest Costpoint 7.1.1 Hot Fixes. 

 

Installation Package Contents 
The Costpoint 7.1.1 installation package contains the following: 

 Costpoint 7.1.1 Database Tier installer 

 Costpoint 7.1.1 Application Tier installer 

 Costpoint 7.1.1 Web Tier installer 

 Deltek Costpoint 7.1.1 New Installation Guide for Oracle 

Installation Prerequisites 

Database Tier Installation Prerequisites 
Before you start the Database Tier installation process, your database server must meet the following 
software prerequisite: 

Prerequisite 
Component 

Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support Site 
here. 

Passwords To run the installation, password is required for Oracle SYSTEM and SYS 
users. 

Note: Please refer to the Installation Prerequisites and System Requirements sections for 
additional information. Also please review the full list of Related Documentation prior to 
installing or upgrading to Costpoint 7.1.1. 

Note: If you need help with this installation, please contact Costpoint Technical Support at 
877.HLP.PROJ (877-457-7765). 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Prerequisite 
Component 

Details 

Oracle Instance and 
Tablespaces 

Create an Oracle instance and Oracle tablespaces as documented in 
“Create Costpoint 7.1.1 Instance(s) and Tablespaces” section. 

Firewall Settings On your Database Server, the Oracle Listener Port (1521) must be open 
for Inbound and Outbound traffic through your firewall. 

On your Database Server, make sure that Network discovery and file 
sharing options are switched on. 

Application Tier Installation Prerequisites 
Before you start the Application Tier installation process, the application server that will run your 
WebLogic Server and Costpoint 7.1.1 software must meet the following prerequisites: 

Prerequisite 
Component 

Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support Site 
here. 

Costpoint 7.1.1 Server Startup Prerequisites 
Before you start Costpoint 7.1.1, the following must be met: 

Prerequisite 
Component 

Details 

Server 

 

On your Database Server, the Oracle Listener Port 1521 must be open for 
Inbound and Outbound traffic through your firewall. 

On your Database Server, make sure that the Network Discovery and 
File Sharing options are switched on. 

On your Application Server, the WebLogic Listener Port 7009 must be 
open for Inbound and Outbound traffic through your firewall. 

On your Application Server, make sure that the Network Discovery and 
File Sharing options are switched on. 

Costpoint 7.1.1 Initial Log In Configuration Prerequisites 
Before you can login to Costpoint 7.1.1 your Windows client computer must meet the following 
requirements: 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Prerequisite 
Component 

Details 

Software 

 

All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support Site 
here. 

Adobe Reader 8.0 or higher. This is required only for users who want to 
print Costpoint 7.1.1 reports in PDF format. Make sure that you select the 
Display PDF in browser option under the In the Preference settings for 
Adobe Acrobat Reader to avoid pulling up a blank IE screen when printing 
in PDF format. 

Web Tier Installation/Microsoft Internet Information Server (IIS) 
Configuration Prerequisites 
The Web server that will host your Internet Information Server software must meet the following 
prerequisites: 

Prerequisite 
Component 

Details 

Software 

 

All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support Site 
here. 

Microsoft Internet Information Server 7.0. 

Installation Process for Costpoint 7.1.1 
The Costpoint 7.1.1 installation process incorporates the following steps:  

Component Change Details 

Database Tier Installation The Database Tier installer automatically creates the following, user 
defined, schemas/users: 

 Transaction Schema (DELTEK) 

 Admin Schema (iCPADMIN) 

 System Schema (CPSYSTEM) 

 Link User (CPLINK_USER) 

Application Tier 
Installation 

The Install function in the Application Tier now automatically installs all 
necessary software and handles all configurations.  

The Application Tier installer automatically performs all the following 
actions: 

 Extracting JDK 

 Installing WebLogic 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Component Change Details 

 Extracting BIRT Lib Files 

 Extracting App Tier Class Files 

 Updating Config Files 

 Encrypting Passwords 

 Running LinkViews 

 Syncing Sys Settings Table 

 Applying License 

 Migrating Org Security Application Modules 

 Creating Demo License 

 Extracting HelpFiles 

 Creating Shortcuts 

The Application Tier installer creates a CostpointToolsGroup with the 
following Sharing and Security permissions: 

 Full Sharing and Security Permissions on your Costpoint 7.1.1 Deltek 
directory (C:\Deltek)  

 Full Security Permissions on your WebLogic directory 
(C:\Oracle\Middleware12.1.3)  

Web Tier Installation The Install function in the Web Tier now automatically installs all 
necessary software and handles all configurations.  

The Web Tier installer automatically perform all of following actions: 

 Extracting Help Files 

 Resetting Internet Information Server 

The Web Tier installer creates a CostpointToolsGroup with the following 
Sharing and Security permissions: 

 Full Sharing and Security Permissions on the folder containing your 
Costpoint 7.1.1 DEWebApp directory (C:\Deltek\Costpoint or 
C:\Deltek\Costpoint\70\applications) 

Web Servers Supported In Costpoint 7.1.1 
The Costpoint 7.1.1 system supports the following Web servers only: 

 Microsoft Internet Information Server  

 Oracle’s WebLogic Web server 

Naming Conventions 
The naming conventions specified in this section are used in all installation instructions detailed in this 
upgrade installation guide. 
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Drive Letters 
The table below lists the drive letters used in the installation instructions: 

Drive Description 

C: The drive where the Costpoint 7.1.1 software is installed. 

Directory Names 
The table below lists the directory names used in the installation instructions: 

Directory Name Description 

ORACLE/MIDDLEWARE12.1.3 The name of the directory where the Oracle WebLogic software is 
installed. 

DELTEK The name of the directory where the Costpoint 7.1.1 software is 
installed. 

Costpoint Schema Names 
The table below lists the typical Oracle schema names used in the Costpoint Database Tier installation: 

Database Name Description 

DELTEK The name of your Costpoint Transaction schema. 

CPSYSTEM The name of the Costpoint System schema. The CPSYSTEM user is a separate 
database schema that stores the metadata that the Costpoint 7.1.1 software needs 
to function properly. 

CPADMIN The name of the Costpoint Admin schema. The CPADMIN user is a separate 
database schema that stores system and security information that the Costpoint 
7.1.1 software needs to function properly. 

Internet Information 
Software installations, installation instructions, technical guides, and release notes are available for 
download from the Deltek Software Manager (DSM). All future releases of Costpoint 7.1.1 are also 
downloaded from DSM.  

DSM is the sole download source for hotfix files. Deltek Knowledge Base articles provide an explanation 
of the fixes and contain links to DSM for retrieval of the actual files. 

Deltek Software Manager Requirements 
You can run DSM from any desktop. It does not need run from Deltek application servers.  

In order to run DSM, you must meet the following requirements: 

 Windows XP or later 
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 Microsoft .NET Framework 3.5 SP1 (3.5.1) 

The following Deltek Knowledge Base article contains a download link to the framework. It also has 
examples of what you may see if you do not have the framework installed: 
https://deltek.custhelp.com/app/answers/detail/a_id/52469 

 

DSM Documentation and Troubleshooting 

 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

 

Knowledge Base Documentation 

To view Knowledge Base articles: 
1. Go to http://www.deltek.com and click Support Login. 

2. Enter your logon credentials in the following fields and click Log In: 

Field Name Description 

Username Your Support user name 

Password Your Support user password. 

If you have forgotten your username or password, click Account Assistance.  

If you have forgotten your username, enter your email address and click Email My Username.  

If you have forgotten your password, enter your username and click Reset My Password. 

3. On the Deltek Support Home Screen, click the Knowledge Center tab, and complete the following 
fields: 

Field Name Description 

Refine by Product Select Costpoint from the drop-down list. 

Refine by 
Category/Version 

Expand Service Pack / Hot Fix from the drop-down list and select 
7.1.1. 

Search Type Use the default value, Phrases, or select your preferred search type 
from the drop-down list. 

Search by Keyword Enter the specific text you are looking for or leave blank to return all 
records for this version. 

Tip: Refer to the DeltekSoftwareManager.pdf to learn more about DSM and how it works. 

Note: The above troubleshooting link will only work if you are logged into Deltek Customer Care 
Connect. 

https://deltek.custhelp.com/app/answers/detail/a_id/52469
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469
http://www.deltek.com/
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4. Click Search. 

5. On the search results screen, perform the following actions: 

 In the Summary column, click the link for the desired correction. 

 When the desired correction loads, click the links in the Answers section to download the 
files. 

System Requirements 
The Costpoint 7.1.1 system uses the following components: 

 Database Tier: Oracle 

 Application Tier: With integrated WebLogic Server 

 Browser Client: Internet Explorer, Chrome, Firefox, Safari 

 Web Tier: Microsoft Internet Information Server (optional) 

 All product compatibility information is maintained in the Deltek Product Support Compatibility 
Matrix available on the Customer Care Support site here. 

 

 
For the most current hardware and software requirements, please refer to the Knowledge Base article 
containing the Compatibility Matrix: 

 https://deltek.custhelp.com/app/answers/detail/a_id/38499 

 https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibility
Matrix.pdf 

Costpoint 7.1.1 Log File Information 
The table below provides information on the log files used by the Costpoint 7.1.1 system. All of these log 
files are located on the Application Server under the C:\Deltek\Costpoint\71\logs folder. 

File Name Description 

DEServer.log This log file is maintained by the WebLogic server instance. In a 
clustered environment each server will write to separate file and 
file name matches the server name. The log records server 
specific events such as the startup and shutdown of servers, the 
deployment of new applications, or the failure of one or more 
subsystems. The messages include information about the time 
and date of the event as well as the ID of the user who initiated the 
event. 

Note: For the Costpoint system to function properly, the system clocks on your WebLogic application 
server and the database server that hosts your Costpoint databases must be synchronized with each 
other. Failure to synchronize your system clocks may result in login and other system problems. 

Note: A hardware recommendations document should have previously been distributed to you. For 
future releases of Costpoint, hardware recommendations will be supplied via a Customer Care 
Knowledge Base article. 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
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File Name Description 

CP_DBConn_DEServer.log This file lists the activate connections uses by the product at given 
time. To enable this logging set 
<SYSTEMNAME>.logDBConnectionProfile = true in enterprise 
properties. In a clustered environment each server will write to a 
separate log file and name the server will determine the name of 
the log file. CP_DBConn_<Server>.log 

CP_DEServer.log This log file contains application specific information such as 
performance, security, and errors encountered while running a 
Costpoint application. Each server will write to a separate log file 
and name the server will determine the name of the log file. 
CP_<Server>.log. 

CP_Security_DEServer.log This file captures messages generated by Costpoint Web security 
module. Messages such as invalid login attempt either due to user 
id, password or insufficient parameters, de-activated user account 
are captured here. In a clustered environment each server will 
write to a separate log file and name the server will determine the 
name of the log file. CP_Security_<Server>.log. 

delteke.log This log file contains information pertained to the entire domain. It 
consolidates log records from all application logs and a subset of 
events recorded in all server logs. All the information gathered is 
written into a single file. Note: Not all log messages are written into 
domain. Only those messages that match the defined severity are 
consolidated. 

service.log This log file contains messages generated by Costpoint Web 
windows service. It helps in troubleshooting issues related to 
service startup, which usually occur during the initial configuration 
stages. In addition to service related messages, it also contains 
most of the information that is captured in the DEServer.log. So, 
after the initially startup issues are sorted out, Deltek suggests 
disabling this log by editing the InstallCPWebasService.cmd 
(C:\Deltek\Costpoint\71\bin folder) and removing the occurrence of 
-log:%CP_ROOT%\logs\service.log. If you remove this after 
installing the service you will need to uninstall and reinstall the 
service for the changes to take effect. 
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Database Tier Installation 
This section provides instructions and recommendations for creating your Costpoint 7.1.1 Transaction, 
System, and Admin database schemas.  

During this installation process, you will install the Costpoint 7.1.1 Database Tier software and 
automatically perform the following: 

 Create and populate a Costpoint 7.1.1 Transaction database schema to store transaction data.  

 Create and populate a Costpoint 7.1.1 System database schema to store meta data.  

 Create and populate a Costpoint 7.1.1 Admin database schema to store system and security 
information. 

 

 

Before You Start 
Make sure that you meet all Database Tier Installation Prerequisites. 

Create Costpoint 7.1.1 Oracle Instance(s) and Tablespaces 
The recommended steps to configure your Oracle instance(s) and set up your Costpoint 7.1.1 database 
tablespaces are detailed in this section. 

This step must be performed on the Oracle database server(s) that will host your DELTEK, CPSYSTEM, 
and CPADMIN database schemas. 

The DELTEK, CPSYSTEM, and CPADMIN database schemas can reside on the same Oracle instance, 
separate Oracle instances on the same, or separate Oracle database servers. 

To create the instance(s) and tablespaces that will host your DELTEK, CPSYSTEM, and CPADMIN 
database schemas: 

1. Use your Oracle database software to create an Oracle instance(s) for hosting the Costpoint 
database. 

The following tables provide a reference for creating your Oracle instance(s). 

These initial settings are only minimal recommendations. Your production environment may need 
to be analyzed and adjusted to meet your specific requirements. You must customize these 
parameters over time based on database size, concurrent users, workload, and so on to achieve 
optimal performance. 

Note: If you use Oracle Real Application Clusters (RAC) and you have two or more Oracle instances, 
make sure that your TRANSACTION, ADMIN, and SYSTEM schemas are all part of one RAC 
database instead of physically separate databases. If you have a critical need to use separate 
databases, please contact Deltek Support. 

Note: The Costpoint platform does not currently support Unicode Translation Format (UTF) character 
sets, such as AL32UTF8. When configuring your Oracle database using Oracle tools, please make 
sure you choose a non-unicode character set, such as WE8MSWIN1252, when creating your initial 
Costpoint database. 
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Oracle Instance Parameter Value 

cursor_sharing EXACT 

db_block_size 8192 

dml_locks 1500 

java_pool_size 32 MB 

job_queue_processes 2 

log_checkpoint_interval 10000 

log_checkpoint_timeout 1800 

open_cursors 2000 

optimizer_index_caching 0 

optimizer_index_cost_adj 100 

optimizer_mode ALL_ROWS 

processes 300 

session_cached_cursors 1500 

timed_statistics TRUE 

sga_target 0 

pga_aggregate_target 0 

statistics_level Typical 

db_file_multiblock_read_count 16 

memory_target Based on database size (1 GB to 15 GB) 

memory_max_target Based on database size (1 GB to 15 GB) 

pga_aggregate_limit (12c only) 0 

 

Tablespace 
Configuration 
Type 

Tablespace Name Minimum Size 
(MB) 

Small Production System (MB) 

System SYSTEM 100 100 

Default COSTPOINT_DATA 200 500 
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Tablespace 
Configuration 
Type 

Tablespace Name Minimum Size 
(MB) 

Small Production System (MB) 

Index COSTPOINT_INDEX 100 300 

Dynamic COSTPOINT_DYN 100 300 

Temporary TEMPORARY_DATA 100 400 

2. For databases over 50GB, Deltek recommends the following additional tablespaces for optimal 
configuration. 

These initial settings are only minimal recommendations. Your production environment may need 
to be analyzed and adjusted to meet your specific requirements. 

Recommended 
Customization 
Tablespace 
Configuration Type 

Tablespace Name Minimum 
Size 
(MB) 

Small Production System 
(MB) 

Temporary Data COSTPOINT_XZDATA 512 2048 

Temporary Index COSTPOINT_XZINDEX 256 1024 

Report Data COSTPOINT_RPTDATA 1024 5120 

Report Index COSTPOINT_RPTINDEX 512 2048 

 

Recommended 
Tablespace 
Configuration Type 
for CPSYSTEM and 
CPADMIN 

Tablespace Name Minimum 
Size 
(MB) 

Small Production System 
(MB) 

System SYSTEM 450 450 

Default CPMETA_DATA 400 400 

Index CPMETA_INDEX 100 100 

Temporary TEMPORARY_DATA 100 100 

Configuring Multiple Costpoint Transaction Schemas with 
Shared Admin / Meta Schema(s) 

 

Note: You can skip this step if you do not want to share your ADMIN or META schemas across 
multiple Costpoint systems. 
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If you want to share your Costpoint Meta and /or Admin schemas across multiple Costpoint Transaction 
schemas and the schemas reside on different databases or on separate database servers, it is necessary 
to configure all the Oracle databases in shared server configuration mode (also called Oracle multi-
threaded server [MTS]). 

An Oracle database creates server processes to handle incoming requests from user processes from 
client machines. A server process is called a dedicated server process when it services and is dedicated 
to only one user process at a time. This is the default configuration for all Oracle databases. A shared 
server process can service multiple user process requests in shared server architecture, thus reducing 
the total number of server processes needed to service a given workload. This allows for a significant 
reduction in system resources and enables the support of an increased number of concurrent users. 

The following recommendation is just the starting point on how to configure your database with shared 
server architecture. It is important to understand your system configuration, number of concurrent users, 
server load, network load, and so on and adjust these settings for optimal performance. There are other 
parameters available that can be adjusted depending on your Oracle RDBMS version. 

The DISPATCHERS initialization parameter configures dispatcher processes in shared server 
architecture. Execute the following statement in SQL Plus: 

ALTER SYSTEM SET DISPATCHERS = '(PROTOCOL=TCP) (DISPATCHERS=2)'; 
The SHARED_SERVERS initialization parameter specifies the minimum number of shared servers 
created at instance startup. Execute the following statement in SQL Plus: 

ALTER SYSTEM SET SHARED_SERVERS = 5; 
Setting this parameter to 0 disables shared server architecture. 

 

Configuring Costpoint on Oracle 
Costpoint 7.1.1 supports both Oracle database architectures: non-CDB's as well as Oracle Multitenant 
(PDB’s). 

Costpoint 7.1.1 fully supports use of pluggable databases (PDB's) that form a part of a container 
database (CDB). When hosting a Costpoint database as a PDB, it is important to allocate adequate 
shared resources and/or limit the number of PDB's in the CDB in order to achieve and maintain optimal 
application performance. The database setup and configuration with Oracle multitenant will vary 
depending on the database workload characteristics, database size, concurrent users, and so on. 

 

Install Database Tier Software 
The steps to install the Costpoint 7.1.1 Database Tier software as well as create the Transaction, System, 
and Admin databases are detailed in this section. 

You must perform this step on your database server or from a client workstation with Oracle client 
connectivity tools installed to connect to the database.  

Note: For more information on Oracle shared server architecture, please refer to Oracle 
documentation for your RDBMS version. 

Tip: Costoint 7.1.1 does not support use of domain name suffixed to the Oracle service name.  For 
example, Costpoint 7.1.1 does not support orc1.domain.com as your service name. 
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You must have Internet access on the machine where the Costpoint 7.1.1 installer is invoked in order to 
download the latest DeltekCostpoint711DatabaseUpgradeFiles.exe and 
DeltekCostpointRequirementsINI.exe files automatically. The 
DeltekCostpoint711DatabaseUpgradeFiles.exe contains the latest database patch rollback scripts as well 
as the latest list of Costpoint 7.0.1 database patches that have been worked into the upgrade. The 
DeltekCostpointRequirementsINI.exe contains the latest OS platforms and database versions supported. 
These files are automatically downloaded when you launch the Database Tier installation, assuming that 
your database server has Internet access.  

 
If your database server does not have internet access, you will need to perform the steps in the Latest 
Upgrade Files Download section of this document before you run the 
DeltekCostpoint711DatabaseTier.exe file. 

To install the Database Tier software: 
1. Run the DeltekCostpoint711DatabaseTier.exe file to launch the Costpoint 7.1.1 Database Tier 

installation program. The Welcome to the InstallShield Wizard for Costpoint screen displays. 

 
2. Click Next >.  

3. On the License Agreement screen, review the license agreement, select I accept the terms of 
the license agreement, and click Next >.  

4. On the Choose Costpoint Database Scripts Directory screen, click Browse to navigate to an 
installation location for the Costpoint 7.1.1 Database Tier software, and click Next >.  

The default installation location is C:\Program Files\Deltek\Costpoint\7.1.1 (recommended). 
Click.  

5. On the Select Deltek Costpoint Install Type screen, select New Install, and click Next >.  

6. On the Select Database Platform screen, select Oracle, and click Next >.  

7. On the Oracle Home Information screen, from the drop-down list, select the Oracle Home 
location for your Costpoint database, and click Next >.  

The installer will read your registry to display all available Oracle Home locations. 

8. On the Deltek Costpoint 7.1.1 Transaction Oracle Database Information screen, complete the 
following fields. 

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server.  To improve security, these connections have been modified to require 
communication over HTTPS. 

Note: Due to enhanced security in Microsoft Windows Server, it is advised that you use the 
Run as Administrator option when launching installation files, even if you are logged in as a 
user with local administrative rights. To Run as Administrator, right-click the 
DeltekCostpoint711DatabaseTier.exe file in Windows Explorer and select Run as 
Administrator. 
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Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 7.1.1 Transaction (DELTEKCP) 
database server. The default value is your computer name. 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. If you have SCAN listener setup, please use the 
Scan hostname or Scan IP Address. Do not use the Virtual IP Address. 

Port Enter the Oracle listener port of your Costpoint database server. The 
default port for Oracle is 1521. 

SID/SERVICE 
NAME 

Select SID or SERVICE NAME and then enter the system identification 
name (SID) or Service Name (ORC1) for the Oracle instance where your 
Costpoint Transaction database schema will be created. The default is 
ORC1.  In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ - _ 

Please note a . (period character) is not supported as part of the 
Service Name. 
Deltek Costpoint requires the Oracle Database SERVICE_NAME to be 
the DB_NAME value only, meaning the DB_DOMAIN value must be 
empty. Therefore, the SERVICE_NAME must use the “dbname” format, 
and not “dbname.dbdomain”. 

Oracle Database software identifies a database by its global database 
name. A global database name consists of the database name and 
database domain. The DB_NAME parameter and the DB_DOMAIN 
parameter combine to create the global database name value assigned 
to the SERVICE_NAMES parameter in the initialization parameter file. 

 

For databases on Oracle 12c, Service Name must be selected. 

For databases on other Oracle versions, you are free to choose either 
the SID or the Service Name to connect to the Costpoint database. The 
Oracle SID pertains to the unique name that identifies an Oracle 
instance. If SID is used, then the SID must be registered with the listener 
on the database server hosting the Costpoint database. 

Similarly, if a Service Name is entered, the Service Name must be a 
valid service registered with the listener on the database server hosting 
the Costpoint database. 

For RAC installations, you may specify the Oracle Instance (SID) of one 
of the instances, or use the Service Name depending on your Oracle 
RDBMS version. 
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Field Name Action 

User Name Enter the name for your Transaction schema user account. The default 
is DELTEK.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ - _ 

Password Enter the password for your Transaction schema user account.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Confirm 
Password 

Re-enter the password for your Transaction schema user account.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account.  In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

9. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays:  

“User DELTEK will be created. Click Next.” 

If the message above does not display, correct the connection information, and click Test 
Connection again. 

10. After receiving the message, click Next >.  

11. On the Deltek Costpoint 7.1.1 Admin Oracle Database Information screen, complete the following 
fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 7.1.1 Admin (CPADMIN) database 
server. The default value is your computer name. 

The value entered in the IP Address or Hostname field cannot be 
127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. If you have SCAN listener setup, please use the 
Scan hostname or Scan IP Address. Do not use the Virtual IP Address. 

Port Enter the Oracle listener port of your Costpoint database server. The 
default port for Oracle is 1521. 
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Field Name Action 

SID/SERVICE 
NAME 

Select SID or SERVICE NAME and then enter the system identification 
name (SID) or Service Name (ORC1) for the Oracle instance where your 
Costpoint Admin database schema will be created. The default is ORC1.  
In addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ - _ 

Please note a . (period character) is not supported as part of the 
Service Name. 
Deltek Costpoint requires the Oracle Database SERVICE_NAME to be 
the DB_NAME value only, meaning the DB_DOMAIN value must be 
empty. Therefore, the SERVICE_NAME must use the “dbname” format, 
and not “dbname.dbdomain”. 

Oracle Database software identifies a database by its global database 
name. A global database name consists of the database name and 
database domain. The DB_NAME parameter and the DB_DOMAIN 
parameter combine to create the global database name value assigned 
to the SERVICE_NAMES parameter in the initialization parameter file. 

 

For databases on Oracle 12c, Service Name must be selected. 

For databases on other Oracle versions, you are free to choose either 
the SID or the Service Name to connect to the Costpoint database. The 
Oracle SID pertains to the unique name that identifies an Oracle 
instance. If SID is used, then the SID must be registered with the listener 
on the database server hosting the Costpoint database. 

Similarly, if a Service Name is entered, the Service Name must be a 
valid service registered with the listener on the database server hosting 
the Costpoint database. 

For RAC installations, you may specify the Oracle Instance (SID) of one 
of the instances, or use the Service Name depending on your Oracle 
RDBMS version. 

User Name Enter the name for your Admin schema user account. The default user is 
CPADMIN.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ - _ 

Password Enter the password for your Admin schema user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Confirm 
Password 

Re-enter the password for your Admin schema user account.  In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 
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Field Name Action 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account.  In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

12. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays:  

“User CPADMIN will be created. Click Next.”  

If the above message does not display, correct the connection information and click Test 
Connection again. 

13. After receiving the message, click Next >. 

14. On the Deltek Costpoint 7.1.1 System Oracle Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 7.1.1 Admin (CPADMIN) database 
server. The default value is your computer name. 

The value entered in the IP Address or Hostname field cannot be 
127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. If you have SCAN listener setup, please use the 
Scan hostname or Scan IP Address. Do not use the Virtual IP Address. 

Port Enter the Oracle listener port of your Costpoint database server. The 
default port for Oracle is 1521. 

SID/SERVICE 
NAME 

Select SID or SERVICE NAME and then enter the system identification 
name (SID) or Service Name (ORC1) for the Oracle instance where your 
Costpoint System database schema will be created. The default is 
ORC1.  In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ - _ 

Please note a . (period character) is not supported as part of the 
Service Name. 
Deltek Costpoint requires the Oracle Database SERVICE_NAME to be 
the DB_NAME value only, meaning the DB_DOMAIN value must be 
empty. Therefore, the SERVICE_NAME must use the “dbname” format, 
and not “dbname.dbdomain”. 

Oracle Database software identifies a database by its global database 
name. A global database name consists of the database name and 
database domain. The DB_NAME parameter and the DB_DOMAIN 
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Field Name Action 

parameter combine to create the global database name value assigned 
to the SERVICE_NAMES parameter in the initialization parameter file. 

 

For databases on Oracle 12c, Service Name must be selected. 

For databases on other Oracle versions, you are free to choose either 
the SID or the Service Name to connect to the Costpoint database. The 
Oracle SID pertains to the unique name that identifies an Oracle 
instance. If SID is used, then the SID must be registered with the listener 
on the database server hosting the Costpoint database. 

Similarly, if a Service Name is entered, the Service Name must be a 
valid service registered with the listener on the database server hosting 
the Costpoint database. 

For RAC installations, you may specify the Oracle Instance (SID) of one 
of the instances, or use the Service Name depending on your Oracle 
RDBMS version. 

User Name Enter the name for your System schema user account. The default user 
is CPSYSTEM.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ - _ 

Password Enter the password for your System schema user account.  In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Confirm 
Password 

Re-enter the password for your System schema user account.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account.  In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

15. Click Test Connection.  

16. If you have entered the proper database connection information, a message similar to the 
following displays:  

“User CPSYSTEM will be created. Click Next.”  

If the above message does not display, correct the connection information and click Test 
Connection again. 

17. After receiving the message, click Next >. 

One of the following screens displays: 
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 Deltek Costpoint 7.1.1 Transaction Oracle Parallel Execution 

 Deltek Costpoint Default and Temporary Tablespace Configuration 

If you do not see the Deltek Costpoint 7.1.1 Transaction Oracle Parallel Execution screen, it 
means Parallelism is not enabled on your Oracle Instance. 

18. If the Deltek Costpoint 7.1.1 Transaction Oracle Parallel Execution screen displays, select the 
Enable Parallel Execution check box to use parallel execution during the new installation 
process.  

This check box is selected by default. 

When using Parallelism, Deltek recommends using the Oracle Defaults for parallel execution. 

19. Click Next >. 

20. On the Deltek Costpoint Default and Temporary Tablespace Configuration screen, complete the 
following fields, and click Next >. 

Schema 
Tablespace 
Information 

Field Name Action 

Costpoint 
TRANSACTION 
Schema 
Tablespace 

Default Select your default tablespace for the Costpoint 
Transaction Schema.  

Deltek recommends that you use 
COSTPOINT_DATA as the tablespace value. 

Temporary Select your temporary tablespace for the Costpoint 
Transaction Schema.  

Deltek recommends that you use 
TEMPORARY_DATA as the tablespace value. 

Costpoint ADMIN 
Schema 
Tablespace  

Default Select your default tablespace for the Costpoint 
Admin Schema.  

Deltek recommends that you use CPMETA_DATA 
as the tablespace value. 

Temporary Select your temporary tablespace for the Costpoint 
Admin Schema.  

Deltek recommends that you use 
TEMPORARY_DATA as the tablespace value. 

Costpoint SYSTEM 
Schema 
Tablespace 

Default Select your default tablespace for the Costpoint 
System Schema. 

Deltek recommends that you use CPMETA_DATA 
as the tablespace value. 

Temporary Select your temporary tablespace for the Costpoint 
System Schema.  

Deltek recommends that you use 
TEMPORARY_DATA as the tablespace value. 
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21. On the Transaction Custom Tablespace Configuration (optional) screen, complete the following 
fields, and click Next >. 

Field Name Action 

Costpoint Index 
Tablespace 

Select your default tablespace for the Costpoint Indexes.  

Deltek recommends that you use the default value, 
COSTPOINT_DATA, unless your database is over 50G. In which case, 
Deltek recommends that you use COSTPOINT_INDEX as the 
tablespace value. 

Costpoint 
Temporary Data 
Tablespace 

Select your default tablespace for the Costpoint Temporary Data (X_Z_ 
and Z_ tables).  

Deltek recommends the default value, COSTPOINT_DATA, unless your 
database is over 50G. In which case, Deltek recommends that you use 
COSTPOINT_XZDATA as the tablespace value. 

Costpoint 
Temporary Index 
Tablespace 

Select your default tablespace for the Costpoint Temporary Indexes 
(X_Z_ and Z_ tables).  

Deltek recommends the default value, COSTPOINT_DATA, unless your 
database is over 50G. In which case, Deltek recommends that you use 
COSTPOINT_XZINDEX as the tablespace value. 

Costpoint Report 
Data Tablespace 

Select your default tablespace for the Costpoint Report Data.  

Deltek recommends the default value, COSTPOINT_DATA, unless your 
database is over 50G. In which case, Deltek recommends that you use 
COSTPOINT_RPTDATA as the tablespace value. 

Costpoint Report 
Index Tablespace 

Select your default tablespace for the Costpoint Report Indexes.  

Deltek recommends the default value, COSTPOINT_DATA, unless your 
database is over 50G. In which case, Deltek recommends that you use 
COSTPOINT_RPTINDEX as the tablespace value. 

22. On the Deltek Costpoint 7.1.1 Link User Information screen, complete the following fields. 

Field Name Action 

User Name Enter the name of your LINK user account. The default value is 
CPLINK_USER. The user (schema) should not exist in the database.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ - _ 

Password Enter the password for your LINK user account.  In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 



Database Tier Installation 

New Installation Guide for Oracle® 26 

 

Field Name Action 

Confirm 
Password 

Re-enter the password for your LINK user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

23. Click Test Connection.  

If you have entered the proper database connection information, a message similar to the 
following displays:  

“User CPLINK_USER will be created. Click Next.”  

If the above message does not display, correct the connection information and click Test 
Connection again. 

24. After receiving the message, click Next >. 

25. On the Pre-Installation Summary screen, review the installation parameters you have selected: 

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process will commence and create objects needed for Costpoint 
7.1.1. Please do not interrupt the process. A Windows Command Prompt will appear on your 
screen that displays the scripts that are being executed. 

The installation will perform the scenarios detailed in the Installation Process for Costpoint 7.1.1 
section of this document. The installation process will stop if any errors are encountered. If any 
errors occur during the installation, please refer to the Troubleshooting Instructions section of this 
document. 

26. On the InstallShield Wizard Complete screen, select the Yes, I want to view the log file check 
box to open the DeltekCostpoint711DatabaseTierInstallLog_<date>_<time>.txt file from the 
C:\Program Files\Deltek\Costpoint\7.1.1\Logs directory.  

This check box is selected by default. 

27. Click Finish to exit the installation. 

28. When the DeltekCostpoint711DatabaseTierInstallLog_<date>_<time>.txt file opens, search for 
the following keywords: 

 “Error”: Report any search results to Deltek Costpoint Technical Support. You can ignore 
"Warning: Procedure created with compilation errors" and “Warning: Package Body created 
with compilation errors”. These errors will be fixed after Link Views are run during the 
Application Tier installation process. 

 “Database Installation For New Costpoint 7.1.1 TRANSACTION Completed 
Successfully” and then the line “$DBSUCCESS=TRUE”. 

  “Database Installation For New Costpoint 7.1.1 ADMIN Completed Successfully” and 
then the line “$DBSUCCESS=TRUE”. 

 “Database Installation For New Costpoint 7.1.1 SYSTEM Completed Successfully” and 
then the line “$DBSUCCESS=TRUE”. 

Finding the three items listed above indicates that you have successfully installed the Costpoint 
7.1.1 Database Tier software and that you have created all of your users (schemas). 
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Make sure that the default Oracle Port (1521) is open for Inbound and Outbound traffic through 
your firewall. Also, make sure that Network Discovery and File Sharing options are switched on. 

Apply Partitioning Script for Performance Enhancement 
The steps to applying partitioning scripts to your Costpoint 7.1.1 TRANSACTION database schema are 
detailed in this section. 

 
Partitioning for the following Costpoint tables and corresponding indexes is supported by the upgrade 
scripts starting with Costpoint 7.0 GA. 

Table Name Index Name 

POOL_SIE_SUPPORT SI_1305 

PSR_FINAL_DATA SI_1822 

PSR_HDR SI_1821 

PROJ_SUM PI_0737 

PROJ_BURD_SUM PI_0736 

RPT_REVENUE_WKS SI_1485 

RPT_PROJ_LAB_SUM SI_1037, SI_1038 

RPT_REV_SUM SI_1218 

RPT_PROJ_TMA SI_0015 

The CostpointPartitionTables.sql file contains scripts for creating partitioned tables and indexes using 
the default partitioning scheme recommended by Deltek. You can choose to change the partitioning 
scheme to suit your requirements. 

If the entire script is executed, for each table, the script will create a temporary partitioned table, move the 
data from the existing non-partitioned table to the partitioned version, create local partitioned indexes, and 
drop the original non-partitioned table. 

The partitioned tables and indexes are created in the default Oracle tablespace of the Transaction 
schema (DELTEK). To modify this behavior or to retain the tablespace settings of the corresponding 
original non-partitioned tables, you will need to modify the appropriate script by adding the tablespace 
information, where necessary. 

To partition a subset of the tables in the list above, you are expected to modify the script suitably before 
execution. Please make provision for adequate disk space and appropriate tablespace settings before 
executing the script. 

While out-of-the-box partitioning should work well for a majority of customers, Deltek recommends that 
larger customers who need to get the most performance out of Costpoint applications consider modifying 

Warning: This is an optional step for clients who run Oracle Enterprise edition licensed with 
partitioning support. All other clients must skip this step. 
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the partitioning model and include the Fiscal Year column as an additional partition parameter on top of 
the columns used by Deltek. 

If you use this approach, Fiscal Year should be the first column in the range criteria. Fiscal year 
partitioning is especially beneficial if you store multiple years of data in the above tables. 

You must perform this step on your Costpoint 7.1.1 Transaction database server. 

To apply the partitioning script: 
1. Click Start » All Programs » SQLPlus. 

2. Connect to your Costpoint 7.1.1 TRANSACTION database using your Transaction schema ( 
DELTEK) user account, and execute the following SQL script: 
CostpointPartitionTables.sql 

The script is located in this folder: C:\Program 
Files\Deltek\Costpoint\7.1.1\Database\Scripts\Oracle\7.1.1\New\Transaction\Scripts 

3. Exit out of SQLPlus. 
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Application Tier Installation 
The Costpoint 7.1.1 system uses Oracle’s WebLogic Server for its application server tier. During the 
Application Tier installation process, you will install the WebLogic Server 12.1.3 application server 
software and the Costpoint 7.1.1 software. 

As previously mentioned in the Pre-Installation Instructions section, the Costpoint 7.1.1 WebLogic 
application server must not contain any previous versions of WebLogic. 

Before You Start 
Make sure that you meet all Application Tier Installation Prerequisites. 

Install Application Tier Software 
This step provides instructions for installing Oracle’s WebLogic Server 12.1.3 application server software 
and Deltek Costpoint 7.1.1 software. 

You must perform this step on the machine that will serve as your Costpoint 7.1.1 application server. 

You must have Internet access on the machine where the Costpoint 7.1.1 installer is invoked in order to 
download the latest DeltekCostpointRequirementsINI.exe file automatically. The file contains the latest 
OS platforms and database versions supported. The file is automatically downloaded when you launch 
the Application Tier installation, assuming that your application server has Internet access.  

 
If your application server does not have internet access, you will need to perform the steps in the Latest 
Upgrade Files Download section of this document before you run the 
DeltekCostpoint711ApplicationTier.exe file. 

To install the Application Tier software: 
1. Run the DeltekCostpoint711ApplicationTier.exe file to launch the Costpoint 7.1.1 Application 

Tier installation program. On the Welcome to the InstallShield Wizard for Costpoint screen, click 
Next >.   

 
2. Review the license agreement, select I accept the terms of the license agreement, and click 

Next >.  

3. On the Select Deltek Costpoint Install Type screen, select New Install, and click Next >. 

4. On the Setup Type screen, complete the following fields, and click Next >. 

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server.  To improve security, these connections have been modified to require 
communication over HTTPS. 

Note: Due to enhanced security in Microsoft Windows Server, it is advised that you use the 
Run as Administrator option when launching installation files, even if you are logged in as a 
user with local administrative rights. 
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Field Name Action 

Primary Application 
Server Tier 

Select this setup type to install both the Oracle WebLogic and Deltek 
Costpoint Application Tier software.  

This option must be selected if installing Costpoint in a non-clustered 
environment or if this will be your Primary Application Server Tier in a 
clustered environment. 

Additional changes are required to configure a clustered environment. 

Secondary 
Application Server 
Tier 

Select this setup type to install only the Oracle WebLogic software. 
The Deltek Costpoint Application Tier software will not be installed.  

This option must only be selected when configuring a clustered 
environment after your Primary Application Server Tier has already 
been installed. 

5. On the Choose Oracle WebLogic Installation Directory screen, click Browse to navigate to an 
installation location for the Oracle WebLogic software, and click Next >.  

The default is C:\Oracle\Middleware12.1.3 (recommended). 

Do not install the WebLogic Server software in a directory path or folder that contains a space. 
The Costpoint 7.1.1 software will not function properly if the WebLogic Server software is installed 
to a directory path or folder that contains a space.  

6. If you select Secondary Application Server Tier for the Setup Type, the Pre-Installation 
Summary screen displays. Proceed to step 23 of this procedure. 

7. On the Choose Deltek Costpoint Installation Directory screen, navigate to the location where you 
want the Costpoint 7.1.1 software installed, and click Next >.  

The default directory is C:\Deltek (recommended). 

The directory in which you install the Costpoint 7.1.1 software cannot be the Oracle WebLogic 
install directory (C:\Oracle\Middleware12.1.3). 

 
8. On the Choose License File screen, click Browse to navigate to the folder containing the Deltek 

supplied LICENSE.ZIP file, and click Next >. 

9. On the Select Database Platform screen is displayed, select Oracle, and click Next >.  

10. On the Oracle for Deltek Costpoint 7.1.1 Transaction Database Information screen, complete the 
following fields. 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Costpoint 7.1.1 Transaction (DELTEKCP) database 
server. The default value is your computer name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 

Note: If you choose to install to a different drive, Deltek strongly recommends that you use 
the same Deltek default directory (E:\Deltek). 
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Field Name Action 

For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Port Enter the port that your Costpoint 7.1.1 Transaction database server 
software uses to listen for requests. The default port for Oracle is 1521. 

Service Name Enter the service name (ORC1) for the Oracle instance where your 
Costpoint 7.1.1 Transaction (DELTEKCP) database schema resides. The 
default value is ORC1.  In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ - _ 

The Service Name must be a valid service registered with the listener on 
the database server hosting the Costpoint database. The Oracle Net 
Connect Descriptor on the client machine uses "Service_Name" in the 
instance portion to specify the database to connect to in the file 
tnsnames.ora. 

Oracle creates one default service with the same name as the SID when 
a database is created. This service registers with the local listener to 
provide access to the database. Customers can choose to create other 
service names as needed. 

For RAC installations, you must specify the Service Name of one of the 
instances. 

User Name Enter the name of your DELTEK user. The default is DELTEK.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ - _ 

Password Enter the password for your DELTEK user.  In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

11. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

12. After receiving the message, click Next >.  
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13. On the Oracle for Deltek Costpoint 7.1.1 Admin Database Information screen, complete the 
following fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Costpoint 7.1.1 Transaction (DELTEKCP) database 
server. The default value is your computer name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Port Enter the port that your Costpoint 7.1.1 Transaction database server 
software uses to listen for requests. The default port for Oracle is 1521. 

Service Name Enter the service name (ORC1) for the Oracle instance where your 
Costpoint 7.1.1 Transaction (DELTEKCP) database schema resides. The 
default value is ORC1.  In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ - _ 

The Service Name must be a valid service registered with the listener on 
the database server hosting the Costpoint database. The Oracle Net 
Connect Descriptor on the client machine uses "Service_Name" in the 
instance portion to specify the database to connect to in the file 
tnsnames.ora. 

Oracle creates one default service with the same name as the SID when 
a database is created. This service registers with the local listener to 
provide access to the database. Customers can choose to create other 
service names as needed. 

For RAC installations, you must specify the Service Name of one of the 
instances. 

User Name Enter the name your CPADMIN user account. The default user is 
CPADMIN.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ - _ 

Password Enter the password for your CPADMIN user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

14. Click Test Connection.  
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If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

15. After receiving the message, click Next >.  

16. On the Oracle for Deltek Costpoint 7.1.1 System Database Information screen, complete the 
following fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for 
example, dbsvr01) of your Costpoint 7.1.1 Transaction (DELTEKCP) 
database server. The default value is your computer name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 
For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Port Enter the port that your Costpoint 7.1.1 Transaction database server 
software uses to listen for requests. The default port for Oracle is 1521. 

Service Name Enter the service name (ORC1) for the Oracle instance where your 
Costpoint 7.1.1 Transaction (DELTEKCP) database schema resides. 
The default value is ORC1.  In addition to standard alphanumeric 
characters, the following special characters are also supported: 

$ - _ 

The Service Name must be a valid service registered with the listener on 
the database server hosting the Costpoint database. The Oracle Net 
Connect Descriptor on the client machine uses "Service_Name" in the 
instance portion to specify the database to connect to in the file 
tnsnames.ora. 

Oracle creates one default service with the same name as the SID when 
a database is created. This service registers with the local listener to 
provide access to the database. Customers can choose to create other 
service names as needed. 

For RAC installations, you must specify the Service Name of one of the 
instances. 

User Name Enter the name your CPSYSTEM user account. The default user is 
CPSYSTEM.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ - _ 

Password Enter the password for your CPSYSTEM user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 
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Field Name Action 

Oracle SYSTEM 
Schema 
Password 

Enter the password for your Oracle SYSTEM user account.  In addition 
to standard alphanumeric characters, the following special characters 
are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

17. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

18. After receiving the message, click Next >.  

19. On the Deltek Costpoint 7.1.1 Link User Information screen, complete the following fields: 

Field Name Action 

User Name Enter the name your LINK user account. The default user is 
CPLINK_USER.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ - _ 

Password Enter the password for your LINK user account.  In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

20. Click Test Connection.  

If you have entered the proper database connection information, the following message displays:  

“Connection Successful. Click Next.”  

If it this message does not display, correct the information entered, and click Test Connection 
again.  

21. After receiving the message, click Next >.  

22. On the Costpoint System Information screen displays, complete the following fields, and click 
Next >. 

Field Name Action 

Listen Port Enter the port that your Application Server will use to listen for 
connections. The default value is 7009. 

System Name Enter the system name that will be used to log on to the Costpoint 7.1.1 
system.  

Deltek recommends that you use your Costpoint 7.1.1 database name, 
DELTEKCP. 
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Field Name Action 

The characters used for the system name must be uppercase and 
alphanumeric. It must not contain any special characters and must be 16 
characters or less in length. 

23. On the Pre-Installation Summary screen, review the installation parameters you have selected: 

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Please do not interrupt 
the process. A Windows Command Prompt will also appear on your screen that displays the 
scripts that are being executed. 

The installation will perform the scenarios detailed in the Installation Process Changes for 
Costpoint 7.1.1 section of this document. The installation process will stop if any errors are 
encountered. If any errors occur during the installation, please refer to the Troubleshooting 
Instructions section of this document. 

24. On the InstallShield Wizard Complete screen, select the Yes, I want to view the log file check 
box to open the  DeltekCostpoint711ApplicationTierInstallLog_<date>_<time>.txt file from the 
C:\Program Files\Deltek\Costpoint\7.1.1\logs directory.  

This check box is selected by default. 

25. Click Finish to exit the installation. 

26. When the DeltekCostpoint711ApplicationTierInstallLog_<date>_<time>.txt file opens, search for 
the following keyword: 

  “Error” – Report any search results to Deltek Costpoint Technical Support. The following 
error messages can be ignored: 
 OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\error401.htm 

 OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\error403.htm 

 OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\error404.htm 

 OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\error500.htm 

 OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\tools\error.png 

 OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\error.png 

 OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_bottomborder-righthand.png 

 OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_bottomborder.png 

 OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_pointer-righthand.png 

 OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_pointer.png 

 OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_topborder-righthand.png 

 OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_topborder.png 
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 OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_vbackground-righthand.png 

 OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_vbackground.png 

If you are running a WebLogic cluster, you must repeat this step for all of your WebLogic servers. 
Running once on your Cluster master, select Primary Application Server Tier for the Setup 
Type, and on each of your cluster nodes, select Secondary Application Server Tier for the 
Setup Type.  

Please refer to the DeltekCostpoint711ConfigurationUtility.pdf technical guide for more 
information on WebLogic clustering. 

Make sure that your default Application Server Listener Port (7009) is open for Inbound and 
Outbound traffic through your firewall. Also, make sure that Network discovery and File Sharing 
options are switched on. 

Add Users to the CostpointToolsGroup 
The steps to add the necessary users to the newly created User Group, CostpointToolsGroup, are 
detailed in this section. The Application Tier installation you just completed has added this group to your 
application server, granting it both Full Sharing and Full Security Permissions to the C:\Deltek folder 
and Full Security Permissions to the C:\Oracle\Middleware12.1.3 folder. 

You must perform this step on your Costpoint 7.1.1 application server. 

To add users to the newly created CostpointToolsGroup: 
1. Click Start » Administrative Tools » Computer Management. For Windows Server 2012, right-

click on Start, and select Computer Management. 
2. From Computer Management » Local Users and Groups » Groups, add the following users to 

the CostpointToolsGroup group: 

 Web Tier (IIS) install user: The user that will run the Web Tier install will need to be in this 
group prior to running that install in the next section. 

 Application Tier (Costpoint) Windows Service account: The user that you will use to start 
and run the Costpoint Windows Service. 

 Application Tier (Costpoint) Tools user: The user that you will use to log in to the 
application server to run any of the Costpoint tools, such as the Config Utility, Migrate User 
Utility, or DBWizard. 

3. Reboot your Costpoint 7.1.1 application server. 

Before You Start 
Make sure that you meet all Costpoint 7.1.1 Server Startup Prerequisites. 

Manually Start Costpoint 7.1.1 
The steps to starting Costpoint 7.1.1 are detailed in this section. You must start the Costpoint 7.1.1 
WebLogic Server on your application server to gain access to the Costpoint 7.1.1 system. 
You must perform this step on your Costpoint 7.1.1 application server. 
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To start Costpoint 7.1.1: 
1. This step is optional. In order for the Start Costpoint 7.1.1 Windows Command Prompt to have 

scrolling capability, perform the following: 

a. Right-click Start, select Search, enter Costpoint 7.1.1, right-click Start Costpoint 7.1.1, and 
click Open file location. 

b. Right-click Start Costpoint 7.1.1 and click Properties on the shortcut menu. 

c. Click the Layout tab and increase the Screen buffer size Height from 300 to 2000. 

d. Click OK to save the changes. 

2. Right-click on Start, select Search, under Costpoint 7.1.1 right-click Start Costpoint 7.1.1, and 
click Run as administrator. 

 
This opens a Windows Command Prompt and launches a command script that starts the 
Costpoint 7.1.1 WebLogic Server. When the Windows Command Prompt window opens, you will 
see a series of messages scrolling down the screen.  

Starting the Costpoint 7.1.1 WebLogic Server can take a long time to complete. Please do not 
interrupt the process. 

3. After the Costpoint 7.1.1 WebLogic Server has successfully started, the following message 
displays at the bottom of the command line shell window: 

<The server started in RUNNING mode.> 
If the Costpoint 7.1.1 WebLogic Server encounters errors during the startup process, the 
message will not display, and the command line shell (DOS window) may terminate. 

If the message does not display or if the command line shell (DOS window) terminates, you must 
perform the following: 

 Make a copy of the C:\Deltek\Costpoint\71\logs\DEServer.log file. 

 Contact Deltek Costpoint 7.1.1 Technical Support. 

Install Costpoint 7.1.1 Windows Service 
The steps to installing the Costpoint 7.1.1 Windows service are detailed in this section. 

This step must be performed on your Costpoint 7.1.1 WebLogic application server. 

To install Costpoint 7.1.1 to run as a Windows service: 
1. Stop the Costpoint 7.1.1 WebLogic Server.  

 
2. Use Windows Explorer to navigate to the directory where the Costpoint 7.1.1 software was 

installed (C:\Deltek\Costpoint\71\bin). Right click InstallCPWebasService.cmd, and select Run 
as administrator. 

Note: Due to enhanced security in Windows Server, it is advised that you use the Run as 
Administrator option when launching this command even if the logged in user has local 
administrative rights. 

Note: See the Stop Costpoint 7.1.1 WebLogic Server from the Web Browser section of this 
document for information on starting and stopping the Costpoint 7.1.1 WebLogic Server. 
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Configure Costpoint 7.1.1 Windows Service 
The steps to configuring the Costpoint 7.1.1 Windows service are detailed in this section. 

This step must be performed on your Costpoint 7.1.1 WebLogic application server. 

To configure Costpoint 7.1.1 Windows service: 
1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services drop-down list, right-click the Costpoint 7.1.1 
service, and then click Properties on the shortcut menu. 

If you do cannot find the Costpoint 7.1.1 service, then the service must not have installed 
properly in the previous step. Please repeat Step 1 of Installing Costpoint 7.1.1 as a Windows 
Service. 

3. On the Costpoint 7.1.1 Properties screen, click the Recovery tab, and complete the following: 

Field Name Action 

First failure Change the drop-down selection from Take No Action to Restart the 
Service. 

Second failure Accept the default value, Take No Action. 

Subsequent 
failures 

Accept the default value, Take No Action. 

Reset fail count 
after 

Change the value from 0 to 1 days. 

Restart service 
after 

Accept the default value, 1 minute. 

4. Click Apply. 

5. On the Costpoint 7.1.1 Properties screen, click the Log On tab and complete the following: 

Field Name Action 

Account Enter the domain Account. For example, Example:  
domain\useraccountname. 

If using a domain service login account instead of using the "Local 
System Account" select This Account. 

Password Enter the password for the domain Account. 

Confirm 
Password 

Re-enter your password for the domain Account. 

6. Click Apply.  

Make sure that the login account for the Costpoint Service is in the local Administrators group on 
the Application Tier server and is part of the local security group created by the Application Tier 
installer, CostpointToolsGroup. 
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Also keep in mind that this login account must be given full access permissions for any Alternate 
File locations set up (network shared directories). Alternate File locations are used for Costpoint 
users for uploading and downloading files from within Costpoint.   

7. On the Costpoint 7.1.1 Properties screen, click the General tab, and click Start to start the 
Costpoint 7.1.1 service. 

The service will indicate that it started immediately. However, please note that it takes several 
minutes for the Costpoint 7.1.1 service to fully initialize. 

After starting the service, wait several minutes before attempting to connect to the software. 

If you encounter problems with the Costpoint 7.1.1 service, check the 
C:\Deltek\Costpoint\71\logs\DEServer.log file and report any errors to Deltek Costpoint 7.1.1 
Technical Support. 

8. Click OK to close the Costpoint 7.1.1 Properties screen, and close the Services window. 
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Web Tier Installation 
The steps to integrate your Costpoint 7.1.1 software with the Microsoft Internet Information Server (IIS) is 
detailed in this section. 

The Microsoft Internet Information Server component is optional. The WebLogic Server software 
included an integrated Web server component that you can use with the Costpoint 7.1.1 software. 

Though the use of the IIS component is optional, Deltek strongly recommends that you install it in your 
production environment. In addition to acting as the proxy, the IIS server is also used to load balance the 
cluster nodes. 

Before You Start 
Make sure that you meet all Web Tier Installation (Microsoft IIS) Prerequisites. 

Configure Microsoft IIS Web Server for Costpoint 7.1.1 
The steps to configure Microsoft IIS prior to the installation of Costpoint 7.1.1 are detailed in this section. 

You must perform this step on a Web server that uses Microsoft Internet Information Server. 

To configure Microsoft IIS Web server: 
1. Click Start » Administrative Tools » Server Manager. 
2. Click Manage and select Add Roles and Features. 

3. On the Before you begin screen, click Next. 
4. On the Select installation type screen, accept the default of Role-based or feature-based 

installation and click Next. 
5. On the Select destination server, accept the default of Select a server from the server pool, 

which should have automatically selected the IIS server you are on, and click Next. 
6. On the Select server roles screen, scroll down and select Web Server (IIS). 
7. On the Add features that are required for Web Server (IIS) screen, click Add Features. 

8. On the Select server roles screen, click Next. 
9. On the Select features screen, click Next. 
10. On the Web Server Role (IIS) screen, click Next. 
11. On the Select role services screen, perform the following: 

 Scroll down, expand Application Development, and select ISAPI Extensions. 

 Scroll down, under Management Tools, expand IIS 6 Management Compatibility, and 
select IIS 6 Metabase Compatibility. 

 Scroll down and select IIS Management Scripts and Tools. 

 Click Next. 
12. On the Confirm installation selection screen, click Install. 
13. After the installation is complete, click Close. 

14. Click Tools and select Internet Information Services (IIS) Manager. 
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15. On the Internet Information Services (IIS) Manager screen, right-click your IIS computer name 
icon, and click Stop. 

16. Right-click your IIS computer name icon again, and click Start. 
17. Close the Internet Information Services (IIS) Manager window. 

18. Close the Services Manager window. 

Install Web Tier Software 
The steps to integrate the Costpoint 7.1.1 system with Microsoft IIS are detailed in this section. 

You must perform this step on a Web server that is using Microsoft Internet Information Server. 

You must have Internet access on the machine where the Costpoint 7.1.1 installer is invoked in order to 
download the latest DeltekCostpointRequirementsINI.exe file automatically. The file contains the latest 
OS platforms and database versions supported. The file is automatically downloaded when you launch 
the Web Tier installation, assuming that your web server has Internet access.  

 
If your application server does not have internet access, you will need to perform the steps in the Latest 
Upgrade Files Download section of this document before you run the DeltekCostpoint711WebTier.exe 
file. 

To install Costpoint 7.1.1 on your Microsoft IIS Web server: 
1. Run the DeltekCostpoint711WebTier.exe file to launch the Costpoint 7.1.1 Web Tier installation 

program.  

 
2. On the Welcome to the InstallShield Wizard for Costpoint screen, click Next >.  

3. Review the license agreement, select I accept the terms of the license agreement, and click 
Next >.  

4. On the Select Deltek Costpoint Install Type screen, select New Install, and click Next >. 

5. On the Choose Deltek Costpoint Installation Directory screen, click Browse to navigate to an 
installation location for the Deltek Costpoint 7.1.1 IIS software.  

The default is C:\Deltek\Costpoint\71\applications (recommended). 

The installation process populates the folder selected above with a \DEWebApp folder that 
contains all the program files you need to integrate the Costpoint 7.1.1 software that resides on 
your application server with your Microsoft IIS Web server. 

6. Click Next >. 

7. On the Deltek Costpoint 7.1.1 WebLogic System Information screen, complete the following 
fields: 

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server.  To improve security, these connections have been modified to require 
communication over HTTPS. 

Note: Due to enhanced security in Windows Server, it is advised that you use the Run as 
Administrator option when launching the executable files even if the logged in user has local 
administrative rights. 
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Field Name Action 

IP Address or 
Hostname 

Enter the IP address (10.2.2.154) or hostname (appsvr01) of your 
Costpoint 7.1.1 WebLogic application server. 

The IP Address or Hostname must not be 127.0.1.0.1 or localhost. 

Listen Port Enter the Listener Port for your Costpoint 7.1.1 WebLogic application 
server. You specified this port during the Costpoint 7.1.1 application 
server software installation. The default port is 7009 (recommended). 

Your Microsoft IIS Web server will use the IP address or hostname 
and Listener Port information to forward requests to your Costpoint 
7.1.1 WebLogic application server. This port must match the one 
entered during the Costpoint 7.1.1 Application Server installation. 

8. Click Next >.  

9. On the IIS Website Name screen, locate the Website Name field and select the Website where 
you wish the Deltek Costpoint 7.1.1 Virtual Directory (CPWeb) to be created, and click Next >.  

Typically, this is the Default Web Site. 

10. On the Choose Deltek Costpoint 7.1.1 Path screen, click Browse to navigate to the shared UNC 
path (\\appsrv01\Deltek_shared) of the Deltek folder that resides on your Costpoint 7.1.1 
Application Server (if your Web Server is also your Application Server just enter the directory, 
C:\Deltek). 

The Windows Administrator user account (or equivalent) on the machine that hosts your 
Costpoint 711 IIS Web server software that is running this installation must exist in the 
CostpointToolsGroup created on your Costpoint 7.1.1 application server. That group has the 
proper write permissions to the C:\Deltek share created on your Costpoint 7.1.1 Application 
Server 

11. On the Pre-Installation Summary screen, review the installation parameters you have selected: 

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Please do not interrupt 
the process.  

The installation will perform the scenarios detailed in the Installation Process Changes for 
Costpoint 7.1.1 section of this document.  

The installation process creates the CPWeb Virtual Directory under the Default Website, using 
the Default App Pool. The process also creates a share of your Costpoint 7.1.1 Costpoint 
directory, C:\Deltek\Costpoint\71\applications. In order for the Application Server (WebLogic) to 
deploy hot fixes and updates, this directory must be shared with Co-Owner (Full Control) rights. 

During the installation process, a new User Group, CostpointToolsGroup, is created and given 
Full Sharing and Security rights on C:\Deltek\Costpoint\71\applications. 

12. On the InstallShield Wizard Complete screen, select No, I will restart my computer later, and 
click Finish. 

13. Open the DeltekCostpoint711WebTierInstallLog_<date>_<time>.txt file (from the C:\Program 
Files\Deltek\Costpoint\7.1.1\logs directory), and search for the following: 
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 “Error” – Report any search results to Deltek Costpoint Technical Support. The following 
errors can be ignored: 

 All of these messages: 
OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\error401.htm 

OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\error403.htm 

OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\error404.htm 

OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\error500.htm 

OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\tools\error.png 

OnInstallingFile - Installing File : C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\error.png 

OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_bottomborder-righthand.png 

OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_bottomborder.png 

OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_pointer-righthand.png 

OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_pointer.png 

OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_topborder-righthand.png 

OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_topborder.png 

OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_vbackground-righthand.png 

OnInstallingFile - Installing File : 
C:\Deltek\Costpoint\71\applications\enterprise\DEWebApp\images\prompt_error_vbackground.png 

Make sure that Network Discovery and File Sharing options are switched on. 

Add Users to the CostpointToolsGroup 
The steps to add the necessary users to the newly created CostpointToolsGroup are detailed in this 
section. The Web Tier installation added this group to your Web server and has granted the group Full 
Sharing and Full Security Permissions to the folder containing your DEWebApp folder, 
C:\Deltek\Costpoint\71\applications. 

You must perform this step on your Costpoint 7.1.1 Web server. 

To add users to the newly created CostpointToolsGroup: 
1. Right-click Start, and select Computer Management. 
2. From Computer Management, Local Users and Groups, Groups, add the following users to 

the CostpointToolsGroup group: 

 Application Tier (Costpoint) Tools user: The user that you will use to log in to the 
application server to run any of the Costpoint tools, such as the Config Utility, Migrate User 
Utility, or DBWizard. 

3. Reboot your Costpoint 7.1.1 Web server. 

Configure Costpoint 7.1.1 IIS Access 
The steps to configure Costpoint 7.1.1 to work through IIS are detailed in this section. 
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You must perform this step on your Costpoint 7.1.1 WebLogic application server. 

To configure Costpoint 7.1.1 and IIS: 
1. With your Costpoint 7.1.1 service running, right-click Start, select Search, enter Costpoint 7.1.1, 

right-click Start Costpoint 7.1.1 Config Utility, and click Run as administrator. 

 
2. On the Select Your Configuration Options screen, make sure the IIS Connection Configuration 

check box is selected and click Next. 
3. On the Costpoint Configuration Utility screen, click the IIS tab and perform the following: 

Field Name Action 

Use IIS Select this check box. This option is cleared by default. 

Configuration File 
Location (iispoxy.ini) 

Click the ellipsis button, and navigate to the \\CPiisServer\Costpoint 
folder share on your IIS server. 

Select the DEProxy\lib folder to access the iisproxy.ini file, and click 
Open. 

Click OK after the following message displays: "Configuration file 
iisproxy.ini was successfully loaded." 

DEWebApp Folder 
Location 

Click the ellipsis button, and navigate to the shared 
\\CPiisServer\Costpoint folder on your IIS server, and click Open. 

WebLogic Host IP Enter your WebLogic application server name. 

Port Enter the WebLogic Listener Port, 7009. 

4. Click Save, the following messages is displayed: 

 
5. Click OK, and click Close. 

Restart Costpoint 7.1.1 WebLogic Server 
The steps to stop and restart your Costpoint 7.1.1 WebLogic Server are detailed in this section. 

You must perform this step on your Costpoint 7.1.1 WebLogic application server. 

To stop and restart your Costpoint 7.1.1 WebLogic Server: 
1. Click Start » Administrative Tools » Services. 

Note: Due to the enhanced security in Windows Server, it is advised to that you use the Run 
as Administrator option when launching this command even if the logged in user has local 
administrative rights. 
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2. On the Services window opens, scroll down the Services list and Stop the Costpoint 7.1.1 
service. 

3. After the service stops, Start the Costpoint 7.1.1 service. 

 
4. Close the Services window. 

Note: The service immediately indicates that it has started. However, please note that it takes 
several minutes for the Costpoint 7.1.1 service to fully initialize. 

After starting the service, wait several minutes before attempting to connect to the software. 

If you encounter problems with the Costpoint 7.1 service, check the 
C:\Deltek\Costpoint\7.1.1\logs\DEServer.log file and report any errors to Deltek Costpoint 
7.1.1 Technical Support. 
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Costpoint 7.1.1 Initial Log In Configuration 
The steps to configure your browser and verify your Costpoint 7.1.1 Application Tier and Web Tier 
installations are detailed in this section. To confirm that these servers are functioning properly, you will log 
in to Costpoint 7.1.1 and preview a report. 

Before You Start 
Make sure that you meet all Costpoint 7.1.1 Initial Log In Configuration Prerequisites. 

Costpoint 7.1.1 Printer Configuration 
This step is optional. It provides configuration instructions for your Application Tier WebLogic Server to 
allow you to print Costpoint 7.1.1 reports. This is useful for asynchronous printing from the server, 
especially for tasks such as printing reports through the Job Server in the middle of the night. 

 
You must perform this step on your Costpoint 7.1.1 application server. 

To create Windows printer objects on your application server: 
1. Right-click Start, click Control Panel, and under Hardware, select View devices and printers. 

2. On the Printers and Faxes screen, double-click Add Printer. 
3. Use the Add Printer Wizard to create a Windows printer object that will connect and print to a 

printer on your network. 

On your application server, you can create as many Windows printer objects as needed for your 
organization. After the printer objects are created, your Costpoint 7.1.1 WebLogic application 
server will make the printer objects available to your users. 

Set Web Browser Internet Options 
The steps to configure the Internet Explorer (IE) browser settings to access the Costpoint 7.1.1 system 
are detailed in this section. 

This step must be performed on all Windows client workstations that will access your Costpoint 7.1.1 
WebLogic application server. 

To configure the browser settings for accessing the Costpoint 7.1.1 system: 
1. Open your Web browser.  

2. From the menu bar, click Tools » Internet Options. 

3. On the Internet Options screen, click the General tab, and click Settings under the Browsing 
history section. 

4. On the Temporary Internet Files and History Settings screen, complete the following: 

Note: Users can print to local printers from the workstations without configuring anything in this step. 



Costpoint 7.1.1 Initial Log In Configuration 

New Installation Guide for Oracle® 47 

 

Field Name Action 

Check for newer versions 
of stored pages 

Select Automatically. 

Disk space to use Enter at least 100 Megabytes (MB). 

5. Click OK to close the Settings screen. 

6. On the Internet Options screen, click the Security tab, select Trusted sites, and click Sites. 

Depending on your environment, you may need to add your Costpoint 7.1.1 URL under Local 
Internet instead of Trusted sites. 

7. On the Add this website to the zone, enter http://<IPAddress or ComputerName>, where 
<IPAddress or ComputerName> identifies your Costpoint 7.1.1 WebLogic application server or 
IIS Web server, depending on which server you will be using to access Costpoint 7.1.1 (for 
example, http://10.2.2.154). 

8. Clear the Require server verification (https:) for all sites in this zone check box. 

9. Click Add, and then click Close. 

10. On the Internet Options screen, click the Advanced tab, scroll down under the Browsing section, 
and clear the Reuse windows for launching shortcuts check box. 

11. Click OK to close the Internet Options screen. 

12. From the menu bar, click Tools » Pop-up Blocker » Turn Off Pop-up Block. 

Disable any pop-up blockers or explicitly allow pop-ups for the Costpoint 7.1.1 URL, such as 
http://<IPAddress or ComputerName>, where <IPAddress or ComputerName> identifies your 
Costpoint 7.1.1 WebLogic application server or IIS Web server (for example, http://10.2.2.154). 

13. Close your Web browser. 

Log In To Costpoint 7.1.1 
The steps to log in to Costpoint 7.1.1 are detailed in this section. 

You can perform this step from any Windows client workstation that has TCP/IP access to your Costpoint 
7.1.1 WebLogic application server. 

To log in to Costpoint 7.1.1: 
1. Open your Web browser, and enter one of the following URLs: 

http://<AppServerIPAddress or ComputerName>:<Port> 

http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 7.1.1 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 7.1.1 
WebLogic application server uses to listen for connections. You specified this port value during 
the Costpoint 7.1.1 software installation. The default is 7009 (for example, 
http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 7.1.1 IIS Web 
server (for example, http://10.2.2.156/cpweb). 

2. When the Deltek Costpoint 7.1.1 Welcome screen displays, complete the following fields. 

http://10.2.2.154/


Costpoint 7.1.1 Initial Log In Configuration 

New Installation Guide for Oracle® 48 

 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter password. The password is case-sensitive and must be 
entered in lowercase. Passwords that you create for other user 
IDs may be uppercase, lowercase, or mixed. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 7.1.1 
system during the Application Server Installation. Typically, 
customers use a system name that is identical to their Costpoint 
7.1.1 Database name, DELTEKCP. 

SHOW ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value, or enter a 
specific Costpoint 7.1.1 application. For example, 
COSTPOINT MENU. 

 Company: Enter your company ID. For example, 1. 

 Validation Frequency: Accept the default drop-down 
value, Field. After you have successfully logged in to 
Costpoint 7.1.1, review the online help for a detailed 
explanation of the value you can select for this field. 

Remember log in 
information 

Select this check box to have the system remember your login 
information. This check box is not selected by default. 

3. Click Log In. 

4. Contact Custom Solutions at Deltek if the following message displays:  

“Warning: The custom programs and the database version are not compatible. The custom 
programs may not work properly. Please contact Custom Solutions at Deltek. Do you want to 
continue with the login?” 

5. Click OK, and a screen similar to the following displays. 
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6. From the main menu screen, click Administration » System Administration » System 

Administration Utilities » Rebuild Global Settings. 

 
7. On the Rebuild Global Settings screen, click Default Action. 
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8. On the Processing Complete screen, click OK. 

9. Click File » Close Application to close the Rebuild Global Settings screen, and click OK on the 
unsaved changes message. 

10. From the main menu screen, click Accounting » Multicurrency » Multicurrency Utilities » 
Update Currency Codes for Current Version. 

Note: If you click the right side (down arrow) of the Default Action button, you must also 
select Reload Settings. 
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11. On the Update Currency Codes for Current Version screen, click Default Action. 
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12. On the Processing Complete screen, click OK. 

13. Click File » Close Application to close the Update Currency Codes for Current Version screen. 

14. From the main menu screen, click Administration » System Administration » Printing » 
Manage System Printers. 

 
15. On the Manage System Printers screen displays, click New Record (+).  

Note: If you click the right side (down arrow) of the Default Action button, you must also 
select Initialize Currency Codes for Version. 
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16. Complete the following fields. 

Field Name Action 

Printer ID Click the magnifying glass (circled above in red). This displays all 
printer objects that are available on your Application Server. Select the 
appropriate printer object by clicking in the check box to the left of the 
printer object name and then clicking SELECT. 

Printer Name Enter a descriptive name for the printer object. 

17. Select the Assigned Users/User Groups link located in the lower right corner of the System 
Printers section. 

18. When the focus switches to the Assigned Users/User Groups section at the bottom half of your 
browser window, click New Record (+), and complete the following fields. 

Field Name Action 

User/User Group ID 
or User/User Group 
Name 

Click the magnifying glass for one of these fields. Select a User/User 
Group that should have access to the printer object you specified 
above. 

Company Click the magnifying glass. Select a Company for this User/User 
Group. 
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19. Click SELECT. You must repeat Step 18 for each User/User Group that you want to assign the 
printer object that you specified in Step 16. 

20. Click Save, and click OK when the following message is displayed: “Record modifications 
completed without error.” 

You must repeat items 14-20 for any printer objects on your Application server that you wish to 
make available to your Costpoint 7.1.1 system users. 

21. Click File» Log-out to exit out of Costpoint 7.1.1.  

22. Close your Web browser. 

Verify Costpoint 7.1.1 Printer Configuration 
The steps to verify your Costpoint 7.1.1 printers are detailed in this section. 

This step can be performed from any Windows client workstation that has TCP/IP access to your 
Costpoint 7.1.1 WebLogic application server. 

To verify your Costpoint 7.1.1 printers: 
1. Open your Web browser, and enter one of the following URLs: 

http://<AppServerIPAddress or ComputerName>:<Port> 

http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 7.1.1 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 7.1.1 
WebLogic application server uses to listen for connections. You specified this port value during 
the Costpoint 7.1.1 software installation. The default is 7009 (for example, 
http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 7.1.1 IIS Web 
server (for example, http://10.2.2.156/cpweb). 

2. On the Deltek Costpoint 7 Welcome screen, complete the following fields. 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter the CPSUPERUSER user password. The default is password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 7.1.1 
system during the Application Server Installation process. Typically, 
customers use a system name that is identical to their Costpoint 7.1.1 
Database name, DELTEKCP. 

SHOW ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value, or enter a specific 
Costpoint 7.1.1 application. For example, COSTPOINT MENU. 

 Company: Enter your company ID. For example, 1. 

 Validation Frequency: Accept the default drop-down value, 
Field. After you have successfully logged in to Costpoint 7.1.1, 
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Field Name Action 

review the online help for a detailed explanation of the value you 
can select for this field. 

Remember log in 
information 

Select this check box to have the system remember your login 
information. This option is not selected by default. 

3. Click Log In.  

4. Click OK if the following message displays:  

“Warning: The custom programs and the database version are not compatible. The custom 
programs may not work properly. Please contact Custom Solutions at Deltek. Do you want to 
continue with the login?”  

5. From the main menu screen, click Administration » Security » Security Reports/Inquiries » 
Print User Group Rights Report. 

 
6. On the Print User Group Rights Report screen, click Print Options. 
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7. On the Print Options screen, select the System Printer or the Local Printer Delivery Option, 

depending on how you setup your Application Server printer, and click OK. 

8. On the Print User Group Rights Report screen, click Print Default Report. 

 
If the User Group Rights Report prints correctly, your Costpoint 7.1.1 Application Server printer 
setup is working properly. If the report does not print correctly, please contact Deltek Costpoint 
7.1.1 Technical Support. 
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9. Click File » Close Application to close the Print User Group Rights Report screen. 

10. Click OK when the following message displays:  

“You have unsaved changes. Select Cancel to go back and save changes or select OK to discard 
changes and close the application”.  

11. You can now begin to configure and use the Costpoint 7.1.1 system.  

Please refer to the “Related Documentation” section for a list of all documentation included with 
the Costpoint 7.1.1 release. 

Deltek strongly recommends that you change the CPSUPERUSER user’s password. Please refer 
to the “Change CPSUPERUSER User’s Password” section for instructions. 

Deploy Costpoint as a Progressive Web App  
A Progressive Web App (PWA) is a web application which uses a set of latest technologies to incorporate 
the features which were historically associated with either browser or native applications. As a result, the 
PWA provides the end user with the best of both worlds.  

The Costpoint PWA application provides the same rich set of capabilities regardless of the device. For 
example, if your company configured SAML or FIDO authentication for desktops, it will work on mobile 
devices, with no extra steps or additional deployment/configuration necessary. If you developed an 
Extension, it will work on a desktop, tablet, or phone. If your users access Costpoint from your company 
Azure portal using SSO, it will equally work on a laptop or phone.  

As Costpoint is being constantly enhanced, you can be confident that your company and your users will 
always have access to the latest features and functionality while using Costpoint PWA, regardless of the 
device used to access Costpoint. 

From an IT perspective, the use of Costpoint PWAs on mobile devices have these additional benefits: 

 The instructions to install Costpoint PWA on your device (similar to installing a native app from a 
store) describe a manual process. However, because it is not required to publish PWA 
applications to the store, IT can push Costpoint PWA application to your employee devices using 
standard MDM solutions (for example, MobileIron). 

 If your company has an internal company store which employees should use to download 
applications (for example, using MobileIron store), a PWA application can be published in your 
company store.  

 IT has full control over the version of Costpoint used by users, including the PWA application 
deployed to user devices. When your company IT or Deltek Cloud deploys any new update to 
Costpoint, the PWA applications on user devices will refresh automatically and seamlessly, 
always staying in sync with the version of Costpoint used by your organization. 

 There is no need to worry about backward or forward compatibility issues with the version of 
applications deployed on user devices, and no need to ask or expect users to download an 
updated version of the application from the company store. 

 

Deploy Costpoint PWA on an Android Device 
You can install the Costpoint PWA from the Costpoint Login page or the Chrome browser menu. 

Note: Deploying a PWA application using the steps outlined below does not only create an icon on 
your home screen but also generates a real native application container on your device. For example, 
you can tap the standard App info option for the Costpoint icon on an Android device and it will show 
that the CP icon you just created is a native application, downloaded from Google Play store. 
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To deploy Costpoint PWA via the Costpoint Login page: 
1. On your Android device, open the Costpoint Login page in the Chrome browser. 

2. Tap Add to Home screen link (below the login information) 

3. Name the Costpoint PWA, and then click Add. 

You can now tap the icon on your Home screen to launch Costpoint as a standalone web app. 

To deploy Costpoint PWA via the Chrome browser menu: 
1. On your Android device, open the Costpoint Login page in the Chrome browser. 

2. Tap the menu (three vertical dots) in the upper-right corner. 

3. Tap Add to Home screen. 

4. Name the Costpoint PWA, and then tap Add. 

You can now tap the icon on your Home screen to launch Costpoint as a standalone web app. 

Deploy Costpoint PWA on an iPhone or iPad 

To deploy Costpoint PWA: 
1. On your iPhone or iPad, open the Costpoint Login page in the Safari browser. 

2. Tap the Share button in Safari. 

3. Tap the Add to Home Screen icon. 

4. Tap Add in the upper-right corner. 

5. Name the Costpoint PWA. 

6. Tap Add in the upper-right corner. 

You can now tap the icon on your Home screen to launch Costpoint as a standalone web app. 

Deploy Costpoint PWA on a Desktop  
Deploying the Costpoint PWA on your desktop creates a desktop shortcut to the application. When you 
access Costpoint using the app, more data is visible on your screen. Browser elements, like the address 
bar, tabs, and other controls, are removed, offering a clearer view of your Costpoint data.  

 

To deploy Costpoint PWA in Google Chrome: 
1. Open the Costpoint Login page. 

2. Install Costpoint PWA using one of the following three options: 

a. In the Address bar, click + (Install Costpoint) » Install. 
b. In the browser menu (three vertical dots), click Install Costpoint » Install. 
c. On the Costpoint Login page, click Add to Home Screen » Install 

Note: Support for Microsoft Edge is coming soon. 
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Post-Installation Configuration 

Apply Latest Costpoint 7.1.1 Hot Fixes 
After you have a functioning Costpoint 7.1.1 environment, follow the 
DeltekCostpoint711DeployingHotFixes.pdf installation document to install the latest Costpoint 7.1.1 
hot fixes. 

WebLogic Server Configuration 
The following methods to start and stop your Costpoint 7.1.1 WebLogic Server are detailed in this section: 

 Starting the Costpoint 7.1.1 WebLogic Server as a Windows service 

 Starting the Costpoint 7.1.1 WebLogic Server from the Windows Start menu 

 Starting the Costpoint 7.1.1 WebLogic Server from a Windows Command Prompt 

 Stopping the Costpoint 7.1.1 WebLogic Server as a Windows service 

 Stopping the Costpoint 7.1.1 WebLogic Server from a Web browser 

Start Costpoint 7.1.1 WebLogic Server as a Windows Service 
The steps to start your Costpoint 7.1.1 WebLogic Server as a Windows service are detailed in this 
section. 

This step must be performed on your Costpoint 7.1.1 WebLogic application server. 

To start your Costpoint 7.1.1 WebLogic Server when it is installed as a Windows service: 
1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services list, right-click the Costpoint 7.1.1 service, 
and click Properties on the shortcut menu. 

3. On the Costpoint 7.1.1 Properties screen, click the General tab. 

4. Click Start to start the Costpoint 7.1.1 service. 

The service will indicate that it started immediately. However, please note that it will take several 
minutes for the Costpoint 7.1.1 service to fully initialize. After starting the service, wait several 
minutes before attempting to connect to the software. 

If you encounter problems with the Costpoint 7.1.1 service, check the 
C:\Deltek\Costpoint\71\logs\DEServer.log file and report any errors to Deltek Costpoint 7.1.1 
Technical Support. 

5. Click OK to close the Costpoint 7.1.1 Properties screen. 

6. Close the Services window. 

Start Costpoint 7.1.1 WebLogic Server from the Start Menu 
The steps to start your Costpoint 7.1.1 WebLogic Server from the Windows Start menu are detailed in this 
section. 
This step must be performed on your Costpoint 7.1.1 WebLogic application server. 
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To start your Costpoint 7.1.1 WebLogic Server from the Windows Start menu: 
1. Right-click Start, select Search, enter Costpoint 7.1.1, right-click Start Costpoint 7.1.1, and 

click Run as administrator. 

 
2. This will open a Windows Command Prompt and launch a command script that starts the 

Costpoint 7.1.1 WebLogic Server. When the Windows Command Prompt window opens, you will 
see a series of messages scrolling down the screen. 

It will take several minutes for the Costpoint 7.1.1 WebLogic Server to start. 

3. If your Costpoint 7.1.1 WebLogic Server starts successfully, the following message displays on 
the lower portion of the command line shell window: 

<The server started in RUNNING mode. > 

If your Costpoint 7.1.1 WebLogic Server encounters errors during the startup process, the 
message will not display, and the command line shell (DOS window) may terminate. 

4. If you do not receive the message or the command line shell (DOS window) terminates, you 
should: 

 Make a copy of the C:\Deltek\Costpoint\71\logs\DEServer.log file. 

 Contact Deltek Costpoint 7.1.1 Technical Support. 

Start Costpoint 7.1.1 WebLogic Server from the Windows Command 
Prompt 
The steps to start your Costpoint 7.1.1 WebLogic Server from a Windows Command Prompt are detailed 
in this section. 

This step must be performed on your Costpoint 7.1.1 WebLogic application server. 

To start your Costpoint 7.1.1 WebLogic Server from a command line shell: 
1. Open a Windows Command Prompt, navigate to the C:\Deltek\Costpoint\71\bin folder, and 

launch the following command script: 

StartCPWeb 

You will see a series of messages scrolling down the screen. It takes several minutes for the 
Costpoint 7.1.1 WebLogic Server to start. 

2. If your Costpoint 7.1.1 WebLogic Server starts successfully, the following message displays on 
the lower portion of the command line shell window: 

<The server started in RUNNING mode. > 

If your Costpoint 7.1.1 WebLogic Server encounters errors during the startup process, the 
message will not display, and the command line shell (DOS window) may terminate. 

3. If you do not receive the message or the command line shell (DOS window) terminates, you 
should: 

 Make a copy of the C:\Deltek\Costpoint\71\logs\DEServer.log file. 

Note: Due to the enhanced security in Windows Server, it is advised to that you use the Run 
as Administrator option when launching this command even if the logged in user has local 
administrative rights. 
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 Contact Deltek Costpoint 7.1.1 Technical Support. 

Stop Costpoint 7.1.1 WebLogic Server as a Windows Service 
The steps to stop your Costpoint 7.1.1 WebLogic Server when it is running as a Windows service are 
detailed in this section. 

This step must be performed on your Costpoint 7.1.1 WebLogic application server. 

To stop your Costpoint 7.1.1 WebLogic Server when it is installed as a Windows service: 
1. Click Windows Start » Administrative Tools » Services. 

2. On the Services window opens, scroll down the Services list, right-click the Costpoint 7.1.1 
service, and click Properties on the shortcut menu. 

3. On the Costpoint 7.1.1 Properties screen, click the General tab. 

4. Click Stop to stop the Costpoint 7.1.1 service. 

5. Click OK to close the Costpoint 7.1.1 Properties screen. 

6. Close the Services window. 

Stop Costpoint 7.1.1 WebLogic Server from the Web Browser 
The steps to stop your Costpoint 7.1.1 WebLogic Server from the WebLogic console are detailed in this 
section. 

This step must be performed from a machine that has Web browser client access via TCP/IP to the 
Costpoint 7.1.1 WebLogic application server. 

To stop your Costpoint 7.1.1 WebLogic Server from a Web browser: 
1. Open your Web browser and enter the following, case-sensitive, URL: http://<IPAddress or 

ComputerName>:<Port>/console, where <IPAddress or ComputerName> identifies your 
Costpoint 7.1.1 WebLogic application server and <Port> identifies the unique port number that 
your Costpoint 7.1.1 WebLogic application server uses to listen for connections. You specified 
this port value during the Costpoint 7.1.1 software installation. The default port is 7009 (for 
example, http://10.2.2.154:7009/console). 

2. When the WebLogic Server Administration Console screen displays, complete the following 
fields: 

Field Name Action 

Username Enter system. 

Password Enter the password for the WebLogic Administrative user. The default 
password is weblogic. 

3. Click Login. 

4. On the Welcome system screen, in the left pane, under Domain Structure, select the delteke 
node of the hierarchical tree. 

5. On the Settings for delteke screen, click the Control tab. 

6. Select the check the box to the left of the DEServer(admin) field. 



Post-Installation Configuration 

New Installation Guide for Oracle® 62 

 

7. Click Shutdown, and then click Force Shutdown Now. 

8. When the Domain Life Cycle Assistant screen displays, click Yes. 

9. Close the Web browser screen. 

Change CPSUPERUSER User’s Password 
The steps to change the CPSUPERUSER users password are detailed in this section. 

This step may be performed from any Windows client workstation that has TCP/IP access to your 
Costpoint 7.1.1 WebLogic application server. 

To change the CPSUPERUSER user’s password: 
1. Open your Web browser, and enter one of the following URLs: 

http://<AppServerIPAddress or ComputerName>:<Port> 

http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Costpoint 7.1.1 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 7.1.1 
WebLogic application server uses to listen for connections. You specified this port value during 
the Costpoint 7.1.1 software installation. The default is 7009 (for example, 
http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 7.1.1 IIS Web 
server (for example, http://10.2.2.156/cpweb). 

2. On the Deltek Costpoint 7 Welcome screen, complete the following fields. 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter the CPSUPERUSER user’s password. The default is password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 7.1.1 
system during the Application Server Installation process. Typically, 
customers use a system name that is identical to their Costpoint 7.1.1 
Database name, DELTEKCP. 

SHOW 
ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value, or enter a specific 
Costpoint 7.1.1 application. For example, COSTPOINT MENU. 

 Company: Enter your company ID. For example, 1. 

 Validation Frequency: Accept the default drop-down value, Field. 
After you have successfully logged in to Costpoint 7.1.1, review 
the online help for a detailed explanation of the value you can 
select for this field. 

Remember log in 
information 

Select this check box to have the system remember your login 
information. This option is not selected by default. 
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3. Click Log In. 

4. Click OK if the following message displays:  

“Warning: The custom programs and the database version are not compatible. The custom 
programs may not work properly. Please contact Custom Solutions at Deltek. Do you want to 
continue with the login?” 

5. From the main menu screen, click Administration » Security » System Security » Manage 
Users. 

 
6. On the Manage Users screen, click Query. 
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7. On the Users screen, enter CPSUPERUSER in the ID field, and click Find. 
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8. After the CPSUPERUSER user information loads in the Manage Users screen, click the 

Authentication tab, and complete the following fields.  

Field Name Action 

Authentication 
Method 

Accept the default value, Costpoint Database, from the drop-down 
list. 

Costpoint Password Enter a password for the CPSUPERUSER user.  

The password is case-sensitive and must be between 8 and 20 
characters in length. 

Verify Password Re-enter the password for the CPSUPERUSER user. 

9. Click Save. 

10. After the confirmation message is displayed at the bottom of the screen, click File » Close 
Application to close the Enter/Manage Users screen. 

11. Click File » Log-out to exit out of Costpoint 7.1.1.  
12. Close your Web browser. 

13. Open your Web browser, and enter one of the following URLs: 

http://<AppServerIPAddress or ComputerName>:<Port> 

http://<WebServerIPAddress or ComputerName>/cpweb 
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Where <AppServerIPAddress or ComputerName> identifies your Costpoint 7.1.1 WebLogic 
application server and <Port> identifies the unique port number that your Costpoint 7.1.1 
WebLogic application server uses to listen for connections. You specified this port value during 
the Costpoint 7.1.1 software installation. The default is 7009 (for example, 
http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Costpoint 7.1.1 IIS Web 
serve (for example, http://10.2.2.156/cpweb). 

14. On the Deltek Costpoint 7 Welcome screen, complete the following fields. 

Field Name Action 

Username Enter CPSUPERUSER 

Password Enter the CPSUPERUSER user’s password. The default is password. 

System Enter <Your_System_Name>, where <Your_System_Name> 
identifies the system name you assigned to your Costpoint 7.1.1 
system during the Application Server Installation process. Typically, 
customers use a system name that is identical to their Costpoint 7.1.1 
Database name, DELTEKCP. 

SHOW ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value, or enter a specific 
Costpoint 7.1.1 application. For example, COSTPOINT MENU. 

 Company: Enter your company ID. For example, 1. 

 Validation Frequency: Accept the default drop-down value, 
Field. After you have successfully logged in to Costpoint 7.1.1, 
review the online help for a detailed explanation of the value you 
can select for this field. 

Remember log in 
information 

Select this check box to have the system remember your login 
information. It is selected by default. 

15. Click Log In. 

16. Click OK if the following message displays:  

“Warning: The custom programs and the database version are not compatible. The custom 
programs may not work properly. Please contact Custom Solutions at Deltek. Do you want to 
continue with the login?”  

A screen similar to the following displays. You may begin accessing and using the Costpoint 7.1.1 
system: 
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If you are unable to log in to Costpoint 7.1.1, contact Deltek Costpoint 7.1.1 Technical Support. 

Secure Sockets Layer (SSL) Encryption with Costpoint 7.1.1 
Implementation 
Information regarding the Costpoint Web support for SSL encryption is detailed in this section. This 
section also provides references to additional resources that you can use to learn more about 
implementing SSL with Costpoint 7.1.1. 

Costpoint Web’s Support for SSL 
Costpoint 7.1.1 was tested against and supports SSL implemented on its WebLogic Server and Microsoft 
Internet Information Server (IIS) components. 

 
SSL requirements will vary from customer to customer. Consequently, this section does not provide 
specific instructions for implementing SSL on either your WebLogic Server or IIS components. Instead, 
this section provides third-party informational resources that you can use to learn about and implement 
SSL with your Costpoint 7.1.1 environment. 

Note: The IIS component is optional in the Costpoint Web environment. If you have chosen to deploy 
IIS with your Costpoint Web environment, you may implement SSL on both your IIS and WebLogic 
Server components. 
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Informational Resources for Implementing SSL 
You can implement SSL on either or both of your Costpoint 7.1.1 system’s IIS and WebLogic Server 
components. For help on implementing SSL, please refer to the following URLs: 

 WebLogic Server 

 http://docs.oracle.com/cd/E24329_01/web.1211/e24422/ssl.htm#SECMG384: Oracle 
WebLogic Server documentation that provides an overview of WebLogic’s domestic- and 
exportable-strength SSL licenses as well as step-by-step instructions for implementing SSL 
on your WebLogic Server. 

 IIS 

 http://technet.microsoft.com/en-us/library/cc732230(WS.10).aspx: Microsoft TechNet article 
that provides an overview of using encryption with IIS 7.1.1 and specific instructions for 
configuring SSL. 

 http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-
deed-4056-9592-e721a4889a71.mspx?mfr=true: Microsoft TechNet article that provides an 
overview of using encryption with IIS 6.0 and specific instructions for configuring SSL. 

In addition to consulting these informational resources, you may contact Deltek’s Systems Solutions team 
to arrange assistance for implementing SSL with your Costpoint 7.1.1 system. 

Troubleshooting Instructions 
Troubleshooting instructions for problems with the Database Tier installation are detailed in this section. 

How to Re-Run a Database Tier Installation that Failed 
The steps to repair a Costpoint 7.1.1 Database Tier installation that has failed are detailed in this section. 

If you encounter a failure during the Database Tier installation process: 
1. Click OK if, during the Database Tier Installation, you receive the following error message:  

“Failed upgrading Costpoint (ADMIN, SYSTEM, or TRANSACTION) Database”.  

2. After the installation has completed and a failed installation error message displays on the 
InstallShield Wizard Complete screen, select the Yes, I want to view the log file check box.  

This opens the DeltekCostpoint711DatabaseTierInstallLog_<date>_<time>.txt file from the 
C:\Program Files\Deltek\Costpoint\7.1.1\logs directory).  

3. Click Finish to exit the installation. 

4. When the DeltekCostpoint711DatabaseTierInstallLog_<date>_<time>.txt file opens, run a search 
for the “error” search string. Report all errors found to Deltek Costpoint Technical Support. 

5. Only after you have fixed the error, run the DeltekCostpoint711DatabaseTier.exe file to launch 
the Costpoint 7.1.1 Database Tier installation program again. You will then see the following 
message: 

http://docs.oracle.com/cd/E24329_01/web.1211/e24422/ssl.htm#SECMG384
http://technet.microsoft.com/en-us/library/cc732230(WS.10).aspx
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-deed-4056-9592-e721a4889a71.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/5e0119a8-deed-4056-9592-e721a4889a71.mspx?mfr=true
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6. Click OK to begin re-running the installation. 

A message similar to the following displays. 

 
Repairing the installation will re-run the installation from the beginning of that particular database 
user (schema). In other words, if Transaction fails it will not re-run Admin or System, if System 
fails it will not re-run Admin, and so on. 

Please do not interrupt the installation process. 

7. After the installation has completed, select the Yes, I want to view the log file check box on the 
InstallShield Wizard Complete screen.  

This opens the DeltekCostpoint711DatabaseTierInstallLog_<date>_<time>.txt file from the 
C:\Program Files\Deltek\Costpoint\7.1.1\logs directory).  

8. Click Finish to exit the installation. 

9. When the DeltekCostpoint711DatabaseTierInstallLog_<date>_<time>.txt file opens, search for 
the following keywords: 

 “Error” – Report any search results to Deltek Costpoint Technical Support. You can ignore 
"Warning: Procedure created with compilation errors" and “Warning: Package Body created 
with compilation errors.” These errors will be fixed after Link Views are run during the 
Application Tier installation process. 

 “New User Database Creation For Costpoint 7.1.1 TRANSACTION Completed 
Successfully” and then the line “$DBSUCCESS=TRUE”. 

  “Database Installation For Costpoint 7.1.1 ADMIN Completed Successfully” and then 
the line “$DBSUCCESS=TRUE”. 

 “Database Installation For Costpoint 7.1.1 SYSTEM Completed Successfully” and then 
the line “$DBSUCCESS=TRUE”. 

Finding the three items listed above indicates that you have successfully installed the Costpoint 
7.1.1 Database Tier software and that you have created all of your users (schemas). 

There will be a new log file created each time you have to repair the Database Tier install. You 
may need to look into multiple log files to find all of the above messages. 

10. Return to the “Application Tier Install” section to continue with your Costpoint 7.1.1 installation. 
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Latest Installer Files Download Instructions 
The Costpoint Database Tier installer provides certain command-line options that can be invoked in 
special circumstances. To display the currently supported switches: 

 Open Command Prompt in Administrator Mode 

 Navigate to the directory where the installer is located 

 Type DeltekCostpoint711DatabaseTier.exe /? 

The instructions to download the latest Costpoint 7.1.1 Database upgrade and 
DeltekCostpointRequirementsINI files are detailed in this section. Each installer will automatically 
download the applicable files if your servers have internet access. If your servers do not, you will need to 
run this step for each installer. 

You must perform this step on any machine that has Internet access. 

To download the required upgrade files: 
1. Run the applicable command to retrieve the files from DSM: 

DeltekCostpoint711DatabaseTier.exe /filedynamicdownload 

DeltekCostpoint711ApplicationTier.exe /filedynamicdownload 

DeltekCostpoint711WebTier.exe /filedynamicdownload 

You will see the following screen. 

  
2. After the file downloads a message similar to the following displays, click OK. 
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3. Copy the downloaded DeltekCostpoint711DatabaseUpgradeFiles.exe/ 
DeltekCostpointRequirementsINI.exe file(s) to your server, in the same folder as your ‘.exe’ 
installer file.  

 

 



 

 

About Deltek 
Better software means better projects. Deltek is the leading global provider of enterprise software and 
information solutions for project-based businesses. More than 23,000 organizations and millions of users 
in over 80 countries around the world rely on Deltek for superior levels of project intelligence, 
management and collaboration. Our industry-focused expertise powers project success by helping firms 
achieve performance that maximizes productivity and revenue. www.deltek.com 

http://www.deltek.com/
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